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Preface

Preface

Thank you for purchasing this Sokkia product. The materials
available in this Manual (the “Manual”) have been prepared by
Sokkia for owners of Sokkia products, and are designed to assist
owners with the use of the receiver and its use is subject to these
terms and conditions (the “Terms and Conditions™).

@ Please read these Terms and Conditions carefully.

Terms and Conditions

USE This product is designed to be used by a professional. The user
should have a good knowledge of the safe use of the product and
implement the types of safety procedures recommended by the local
government protection agency for both private use and commercial
job sites.

COPYRIGHT All information contained in this Manual is the
intellectual property of, and copyrighted material of Sokkia. All
rights are reserved. Do not use, access, copy, store, display, create
derivative works of, sell, modify, publish, distribute, or allow any
third party access to, any graphics, content, information or data in this
Manual without Sokkia’s express written consent and may only use
such information for the care and operation of your receiver. The
information and data in this Manual are a valuable asset of Sokkia
and are developed by the expenditure of considerable work, time and
money, and are the result of original selection, coordination and
arrangement by Sokkia.
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TRADEMARKS GRX1™_ Spectrum Survey Office™, Spectrum
Link™, Spectrum Survey Field™, SHC2500™, and SRU™ are
trademarks or registered trademarks of Sokkia. Windows® is a
registered trademark of Microsoft Corporation. The Bluetooth® word
mark and logos are owned by Bluetooth SIG, Inc. and any use of such
marks by Sokkia is used under license. Other product and company
names mentioned herein may be trademarks of their respective
OWNers.

DISCLAIMER OF WARRANTY EXCEPT FOR ANY
WARRANTIES IN AN APPENDIX OR A WARRANTY CARD
ACCOMPANYING THE PRODUCT, THIS MANUAL AND THE
RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER
WARRANTIES. SOKKIA DISCLAIMS ANY IMPLIED
WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY
PARTICULAR USE OR PURPOSE. SOKKIA AND ITS
DISTRIBUTORS SHALL NOT BE LIABLE FOR TECHNICAL OR
EDITORIAL ERRORS OR OMISSIONS CONTAINED HEREIN;
NOR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES
RESULTING FROM THE FURNISHING, PERFORMANCE OR
USE OF THIS MATERIAL OR THE RECEIVER. SUCH
DISCLAIMED DAMAGES INCLUDE BUT ARE NOT LIMITED
TO LOSS OF TIME, LOSS OR DESTRUCTION OF DATA, LOSS
OF PROFIT, SAVINGS OR REVENUE, OR LOSS OF THE
PRODUCT’S USE. IN ADDITION SOKKIA IS NOT
RESPONSIBLE OR LIABLE FOR DAMAGES OR COSTS
INCURRED IN CONNECTION WITH OBTAINING
SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY
OTHERS, INCONVENIENCE, OR ANY OTHER COSTS. IN ANY
EVENT, SOKKIA SHALL HAVE NO LIABILITY FOR
DAMAGES OR OTHERWISE TO YOU OR ANY OTHER
PERSON OR ENTITY IN EXCESS OF THE PURCHASE PRICE
FOR THE RECEIVER.

LICENSE AGREEMENT Use of any computer programs or software
supplied by Sokkia or downloaded from a Sokkia website (the
“Software”) in connection with the receiver constitutes acceptance of
these Terms and Conditions in this Manual and an agreement to abide
by these Terms and Conditions. The user is granted a personal, non-
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Terms and Conditions

exclusive, non-transferable license to use such Software under the
terms stated herein and in any case only with a single receiver or
single computer. You may not assign or transfer the Software or this
license without the express written consent of Sokkia. This license is
effective until terminated. You may terminate the license at any time
by destroying the Software and Manual. Sokkia may terminate the
license if you fail to comply with any of the Terms or Conditions.
You agree to destroy the Software and manual upon termination of
your use of the receiver. All ownership, copyright and other
intellectual property rights in and to the Software belong to Sokkia. If
these license terms are not acceptable, return any unused software and
manual.

CONFIDENTIALITY This Manual, its contents and the Software
(collectively, the “Confidential Information”) are the confidential and
proprietary information of Sokkia. You agree to treat Sokkia’s
Confidential Information with a degree of care no less stringent that the
degree of care you would use in safeguarding your own most valuable
trade secrets. Nothing in this paragraph shall restrict you from
disclosing Confidential Information to your employees as may be
necessary or appropriate to operate or care for the receiver. Such
employees must also keep the Confidentiality Information confidential.
In the event you become legally compelled to disclose any of the
Confidential Information, you shall give Sokkia immediate notice so
that it may seek a protective order or other appropriate remedy.

WEBSITE; OTHER STATEMENTS No statement contained at the
Sokkia website (or any other website) or in any other advertisements
or Sokkia literature or made by an employee or independent
contractor of Sokkia modifies these Terms and Conditions (including
the Software license, warranty and limitation of liability).

SAFETY Improper use of the receiver can lead to injury to persons or
property and/or malfunction of the product. The receiver should only
be repaired by authorized Sokkia warranty service centers. Users
should review and heed the safety warnings in an Appendix.

MISCELLANEOUS The above Terms and Conditions may be
amended, modified, superseded, or canceled, at any time by Sokkia.
The above Terms and Conditions will be governed by, and construed
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in accordance with, the laws of the State of California, without
reference to conflict of laws.

Manual Conventions

This manual uses the following conventions:

Example Description

File » Exit Click the File menu, and click EXit.
Connection Indicates the name of a dialog box or screen.

Frequency Indicates a field on a dialog box or screen, or a tab
within a dialog box or screen.
Enter Press or click the button or key labeled Enter.

Further information to note about the configuration,
maintenance, or setup of a system.

i &
|

Supplementary information that can help you
configure, maintain, or set up a system.

Supplementary information that can have an affect
on system operation, system performance,
measurements, or personal safety.

Notification that an action has the potential to
adversely affect system operation, system
performance, data integrity, or personal health.

|| D ¥
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_{ﬂ- Notification that an action will result in system
damage, loss of data, loss of warranty, or personal
[ WARNING anury
Under no circumstances should this action be
performed.
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Notes:
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Chapter 1

Introduction

The GRX1 receiver is a multi-frequency, GNSS receiver built to be
the most advanced and compact receiver for the surveying market.
The receiver is a multi-function, multi-purpose receiver intended for
survey and construction markets.

The GRX1 receives and processes multiple signal types (including
GPS L1, L2, C/A, L2C GLONASS L1, L2, C/A signals) improving
the accuracy and reliability of the survey points and positions,
especially under difficult jobsite conditions. Several other features,
including advanced multipath mitigation, provide under-canopy and
low signal strength reception. The receiver provides the functionality,
accuracy, availability, and integrity needed for fast and easy data
collection.

Figure 1-1. GRX1 Receiver
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Introduction

Principles of Operation

Surveying with the right GPS receiver can provide users accurate and
precise positioning; a requirement for any surveying project.

This section gives an overview of existing and proposed Global
Navigation Satellite Systems (GNSS) and receiver functions so that
basic operating principles can be applied.

GNSS Overview

Currently, the following two global navigation satellite systems
(GNSS) offer line-of-site radio navigation and positioning, velocity,
and time services on a global, all-weather scale to any user equipped
with a GNSS tracking receiver on or near the Earth's surface:

* GPS - the Global Positioning System maintained and operated by
the United States Department of Defense. For information on the
status of this system, visit the US Naval Observatory website
(http://tycho.usno.navy.mil/) or the US Coast Guard website
(http://www.navcen.uscg.gov/).

* GLONASS - the Global Navigation Satellite System maintained
and operated by the Russian Federation Ministry of Defense. For
information on the status of this system, visit the Coordinational
Scientific Information Center website (http://www.glonass-
ianc.rsa.ru/).

Despite numerous technical differences in the implementation of
these systems, satellite positioning systems have three essential
components:

* Space — GPS and GLONASS satellites orbit approximately
12,000 nautical miles above Earth and are equipped with a clock
and radio. These satellites broadcast ranging signals and various
digital information (ephemerides, almanacs, time and frequency
corrections, and so forth).

* Control — Ground stations located around the Earth that monitor
the satellites and upload data, including clock corrections and
new ephemerides (satellite positions as a function of time), to
ensure the satellites transmit data properly.
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Principles of Operation

* User — The community and military that use GNSS receivers to
calculate positions.

Calculating Absolute Positions

When calculating an absolute position, a stationary or moving
receiver determines its three-dimensional position with respect to the
origin of an Earth-Center Earth-Fixed coordinate system. To calculate
this position, the receiver measures the distance (called pseudo-
ranges) between it and at least four satellites. The measured pseudo-
ranges are corrected for clock differences (receiver and satellites) and
signal propagation delays due to atmospheric effects. The positions of
the satellites are computed from the ephemeris data transmitted to the
receiver in navigation messages. When using a single satellite system,
the minimum number of satellites needed to compute a position is
four. In a mixed satellite scenario (GPS and GLONASS), the receiver
must lock onto five or more satellites to account for the different time
scales used in these systems and to obtain an absolute position.

Calculating Differential Positions

DGPS (Differential GPS) is a relative positioning technique where
the measurements from two or more remote receivers are combined
and processed using sophisticated algorithms to calculate the
receivers’ relative coordinates with high accuracy. DGPS
accommodates various implementation techniques that can be
classified according to the following criteria:

* The type of GNSS measurements used, either code-phase
differential measurements or carrier-phase differential
measurements

 [f real-time or post-mission results are required. Real-time
applications can be further divided according to the source of
differential data and communication link used.

With DGPS in its most traditional approach, one receiver is placed at
a known, surveyed location and is referred to as the reference receiver
or base station. Another receiver is placed at an unknown location and
is referred to as the remote receiver or rover. The reference station
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collects the code-phase and carrier-phase measurements from each
GNSS satellite in view.

* For real-time applications, these measurements and the reference
station coordinates are then built up to the industry standard

RTCM! - or another proprietary standard established for
transmitting differential data — and broadcast to the remote
receiver (s) using a data communication link. The remote receiver
applies the transmitted measurement information to its observed
measurements of the same satellites.

* For post-mission applications, the simultaneous measurements
from reference and rover stations are normally recorded to the
receiver's internal memory (not sent over communication link).
Later, the data are downloaded to computer, combined, and
processed. Using this technique, the spatially correlated errors —
such as satellite orbital errors, ionospheric errors and tropospheric
errors — can be significantly reduced, thus improving the position
solution accuracy.

A number of differential positioning implementations exists,
including post-processing surveying, real-time kinematic surveying,
maritime radio beacons, geostationary satellites (as with the
OmniSTAR service) and satellite based augmentation systems
(WAAS/EGNOS/MSAS).

Additional hardware and/or subscription fees may
be required to use other systems separate from the
GRXT system.

1. The Radio Technical Commission for Maritime Services (RTCM)
defines global standards for communication messages and protocols
that are used in the GNSS positioning industry. In support of this
standards-based approach, Sokkia recommends use of the latest
RTCM message formats (v3 or greater) for all RTK and DGPS
communication needs. Several legacy correction message formats are
also provided by Sokkia GNSS products in order to support
interoperability with older GNSS systems, but their use is now
deprecated.
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The real-time kinematic (RTK) method is the most precise method of
real-time surveying. RTK requires at least two receivers collecting
navigation data and a communication data link between the receivers.
One of the receivers is usually at a known location (Base) and the
other is at an unknown location (Rover). The Base receiver collects
carrier phase measurements, generates RTK corrections and sends
this data to the Rover receiver. The Rover processes this transmitted
data with its own carrier phase observations to compute its relative
position with high accuracy, achieving an RTK accuracy of up to
10mm horizontal and 15mm vertical.

Essential Components for Quality Surveying
Achieving quality position results requires the following elements:

* Accuracy — The accuracy of a position primarily depends upon
the satellite geometry (Geometric Dilution of Precision, or
GDOP) and the measurement (ranging) errors.

— Differential positioning (DGPS and RTK) strongly mitigates
atmospheric and orbital errors.

— The more satellites in view, the stronger the signal, the lower
the DOP number, the higher positioning accuracy.

* Availability — The availability of satellites affects the calculation
of valid positions. The more visible satellites available, the more
valid and accurate the position. Natural and man-made objects
can block, interrupt, and distort signals, lowering the number of
available satellites and adversely affecting signal reception.

* Integrity — Fault tolerance allows a position to have greater
integrity, increasing accuracy. Several factors combine to provide
fault tolerance, including:

— Receiver Autonomous Integrity Monitoring (RAIM) detects
faulty GNSS satellites and removes them from the position
calculation.

— Five or more visible satellites for only GPS or only
GLONASS; six or more satellites for mixed scenario.

— Satellite Based Augmentation Systems (WAAS/EGNOS/
MSADS) creates and transmit, along with DGPS corrections,
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data integrity information (for example, satellite health
warnings).

— Current ephemerides and almanacs.

Conclusion

This overview simply outlines the basics of satellite positioning. For
more detailed information, visit the Sokkia website.

Receiver Overview

When the power is turned on and the receiver self-test completes, the
receiver’s 72 channels initialize and begin tracking visible satellites.
Each of the receiver’s channels can be used to track any one of the
GPS or GLONASS signals. The number of channels available allows
the receiver to track all visible global positioning satellites at any time
and location.

An internal GNSS antenna equipped with a low noise amplifier
(LNA) and the receiver’s radio frequency (RF) device are connected
with a co-axial cable. The wide-band signal received is down-
converted, filtered, digitized and assigned to different channels. The
receiver processor controls the process of signal tracking.

Once the signal is locked in the channel, it is demodulated and
necessary signal parameters (carrier and code phases) are measured.
Also, broadcast navigation data are retrieved from the navigation
frame.

After the receiver locks on to four or more satellites, its absolute
position in WGS-84 and the time offset between the receiver clock
and GPS time are computed. This information and the measurement
data can be stored in the optional SD card and downloaded later onto
a computer, then processed using a post-processing software package.
When the receiver operates in RTK mode, raw data measurements
can also be recorded into the receiver’s internal memory. This allows
the operator to double check real-time results obtained in the field.

Depending on your options, capabilities of the receiver include:
* Satellite based augmentation systems (WAAS/EGNOS/MSAS).
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Adjustable phase locked loop (PLL) and delay lock loop (DLL)
parameters

Single- or Dual-frequency signal tracking modes, including
static, kinematic, real-time kinematic (RTK)

Differential GPS (DGPS) survey modes (DGPS modes include
static, kinematic, and RTK)

Automatic data logging

Setting different mask angles, Setting different survey
parameters, Static or dynamic modes

Measurement and position output rates, up to 20 Hz
Ability to update the firmware in the field

Configurable long-range radios

Getting Acquainted

The GRX1 is a 72-channel GPS receiver, which includes the
following:

Detachable battery
One data port
One power port

Interface for controlling and viewing data logging, tracked
satellites and power status (LED display panel)

External memory card slot

Internal radio modem

Bluetooth wireless technology module
Optional GSM/GPRS/EDGE module

Optional HSPA module (only with the Digital UHF II radio
modem)

Audible status messages
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GRX1 Receiver

The GRX1 receiver’s advanced design reduces the number of cables
required for operation, allowing for more reliable and efficient
surveying. The casing allocates space for one removable battery, SD
and SIM card slots, Bluetooth wireless technology module and a
radio modem communications board with GSM/HSPA cellar phone
module (depending on the model).

The GRX1 comes in one of the following configurations:
» with a UHF II TX/RX radio modem

¢ with a UHF II TX/RX radio modem and GSM, HSPA, or CDMA
(US) modules

¢ with a Satel radio modem and a GSM/HSPA module

Battery

The GRX1 receiver comes equipped with two detachable Li-Ion
batteries (Figure 1-2 on page 1-9) for powering the receiver and one
CDC68 charger.

The battery is capable of running for more than 7.5 hours on a single
charge (only static observation).

The battery compartment door provides access to the main battery.
The receiver can also be powered using an external power source.

Use one BDC58 rechargeable battery at a time to power the receiver.
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The GRX1 also contains an internal backup battery, which maintains
an internal RTC. The backup battery is automatically charged from
the main battery.

Figure 1-2. GRX1 Battery and Charger

Inserting and Removing the Battery

* First, before removing the battery, always turn off power to the
instrument. If the battery is removed while the power is switched
on, uncontrolled system shutdown will occur and file data may be
lost as a result.

* When inserting or removing the battery, make sure that moisture,
dust, or other foreign particles do not come in contact with the
inside of the instrument.

* Remove batteries from the surveying instrument or charger
before placing into storage.

* Store the battery in a dry room where the temperature is within
the following ranges. For long-term storage, the battery should be
charged at least once every six months.

Table 1-1. Battery Storage Time

Storage Period Temperature
1 week or less -20°C to +50°C
1 week to 1 month -20°C to +45°C
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Table 1-1. Battery Storage Time

Storage Period Temperature
1 month to 6 months -20°C to +40°C
6 months to 1 year -20°C to +35°C

* The BDCS58 uses the latest advances in high density lithium-ion
battery technology. However, like all batteries, it still generates
power using a chemical reaction and as a result, has a limited
lifetime. Even when the battery is in storage and not used for long
periods, the battery capacity deteriorates with the passage of time.
This may result in the operating time of the battery shortening
despite having been charged correctly. In this event, a new
battery is required.

To Remove the Battery:

1. Turn the GRX1 over.

2. Push the battery buttons on both sides of the battery compartment
cover, and lift the battery cover.

N

Figure 1-3. Remove Battery Compartment Cover
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3. Slide the battery to the right, and separate the battery from the
connector.

Slide Battery
to the Right to
Remove

Figure 1-4. Remove Battery

4. Lift up the battery, and remove it from the receiver.

To Insert the Battery:

1. Remove the battery cover.
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2. Gently slide the bottom of the battery along the battery guides
until it snaps into place (Figure 1-5 on page 1-12).

Slide Battery
to the Left to
Lock in Place

Figure 1-5. Remove Battery Compartment Cover

Charging the Battery

To charge the battery, use the included charger. It takes
approximately 4 hours to completely charge one battery, and 8 hours
to completely charge two batteries.

The battery is shipped from the factory without
power. Fully charge the Battery before surveying.

The Li-Ion batteries used in the battery packs should run at no less
than 80% capacity after 500 charging cycles. These batteries do not
need to be drained before recharging.

1. Connect the power cable to the charger and plug the charger into
the wall outlet.
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2. Mount the battery in the charger by matching the grooves on the
battery with the guides on the charger.

Charging lamp

Slot 2

Figure 1-6. Insert Battery onto Charger

3. When charging begins, the lamp light blinks.
4. The lamp light is solid when charging is complete.

5. Remove the battery and unplug the charger.

Figure 1-7. Remove Battery
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Slots 1 and 2:

NOTE The charger starts charging the battery mounted
first. If two batteries are placed in the charger, the
battery in slot 1 is charged first, and then the battery
in slot 2.

Charging lamp:

The charging lamp is off when the charger is
outside the charging temperature range or when the
battery is mounted incorrectly. If the lamp is still
off after the charger falls within its charging
temperature range and the battery is mounted again,
contact a local dealer.

Charging time per battery (at 25°C):

BDC58: about 4 hours (Charging can take longer
than the times stated above when temperatures are
either especially high or low.)
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LED Display Panel

The GRX1 LED status display panel indicates the receiver’s current
status (Figure 1-8).

i Satellite Tracking Bar
Available Power Bar

Memory Capacity Bar
Scheduler
Receiver Wireless Status
Health\ /
\ |

Power
Button = o
Radio
Status
Battery Status
i File Status  Serial Port

Status

Position Status

Figure 1-8. GRX1 LED Display Panel

Available Power Bar indicates the remaining battery charge or
voltage.

* Green — indicates greater than 50%

* Yellow — indicates greater than 25%

* Red - indicates greater than 10%

* Red (blinking) — indicates less than 10%
When GRX1 uses an external power supply:

* Green — indicates greater than 8V

* Yellow — indicates greater than 7.5V

* Red - indicates greater than 6.5V

* Red (blinking) — indicates less than 6.5V

Battery Status LEDs indicates an available battery and the usage
condition.
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* Green — indicates only battery is available
* Red - indicates only external power is available

* Amber — indicates that both battery and external power are
available

Satellite Tracking Bar indicates the number of satellites tracked.
» Green — indicates greater than 8 satellites
* Yellow — indicates 6 or 7 satellites
* Red - indicates 4 or 5 satellites

¢ Red blink — indicates 3, 2, 1 satellites

Position Status LEDs indicate the current type position computed.
* Green — indicates Integer RTK solution
* Yellow — indicates RTK Float or DGPS solution

* Red - indicates Single point position, User fixed position or Base
mode

Memory Capacity Bar indicates a percentage of available space in
the memory.

* QGreen — indicates greater than 50%
* Yellow — indicates greater than 25%

* Red - indicates greater than 10%

Red (blinking) — indicates greater than 0%
* Green/Yellow/Red (blinking) — 0% or memory card is not ready

File Status LEDs indicate the status of the current file.
* Green — indicates a file is open
* Red blink — indicates writing to the file

* NO light (dark) — indicates that a file is not open or there is no
memory card in slot

Wireless Status LEDs indicates the status of the internal Bluetooth
module.
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¢ Blue — internal Bluetooth connection is established

Blue (blinking) — internal Bluetooth connection has not been
made, as long as the module has power

* Green (flashing) — indicates data is transmitted from the
Bluetooth port

* Orange (flashing) — indicates data is received from the Bluetooth
port

* No light (dark) — internal Bluetooth module is turned off.

Radio Status LEDs indicates the status of the internal radio.
* Yellow — indicates internal radio is being powered

* Green (flashing) — indicates data is transmitted from the internal
radio port

* Orange (flashing) — indicates data is received from the internal
radio port

Serial Port Status LEDs indicates the status of the serial port.

* Green (flashing) — indicates data is transmitted from the serial
port

* Orange (flashing) — indicates data is received from the serial port

Scheduler Status LED is not available at this time. The scheduler
status LED feature will be available in future revisions of the GRX1.

The Power Button is used to turn the unit on or off, format or erase
the internal memory, or perform a factory reset. The number of
seconds that you press the power button determines how the receiver
will behave. At each time interval, the receiver issues voice messages
or sounds to guide you through the process.
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Table 1-2. Power Button Action Status

Action N;enggﬁagf Description
Turn On 3 second Press the button for more than 3 seconds and
release to turn on the receiver. The battery life
gauge indicates the progress of the startup
sequence. After startup (approximately 20
seconds), the battery life gauge indicators will
turn off for a short period, and you will hear
the “Receiver Ready” message or sound that
indicates that the system is operational.
Note: It is normal for the receiver health
indicator LEDs to illuminate during startup.
Turn Off greater than 3 Press the button for 3 seconds to 10 seconds
seconds, and and/or until you hear the “Power Off” message
less than 10 or sound, and the top three battery life gauge
seconds LEDs illuminate.
Factory greater than 10 With the receiver on, press the button for 10
reset seconds, and seconds to 20 seconds until you hear the
less than 20 “Factory Reset” message or sound and the top
seconds three LEDs on the battery life, satellite
tracking, and memory gauges illuminate.
Release the button to reset all stored
parameters on the receiver to their default
values.
Note: This action is irreversible.
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Table 1-2. Power Button Action Status

. Number of .
Action Seconds Description

Erase greater than 20, | With the receiver on, press the button for 20
memory and less than 25 | seconds to 25 seconds until you hear the
“Delete Files” message or sound and the top
three LEDs on the memory gauge illuminate.
Release the button to delete all the files from
the memory.

Notice: This action is irreversible. If you are
unsure about whether you want to delete all the
files, hold the button longer than 25 seconds,
so that the receiver simply returns to normal
operation.

To delete individual files from the memory,
use a data collector or Sokkia software, “SRU”
on your PC.

Disregard more than 25 When you hold the button longer than 25
seconds seconds and you hear the “Continue
Operation” message or sound, no action will
be taken and the receiver will return to normal
operation.

The receiver will not turn Off, the data files
will not be erased and the settings will not
revert to factory settings.

Audible Annunciator

The GRX1 receiver is equipped with a voice notification, which
issues a series of voice messages or sounds to alert you to system
status and event conditions.

messages or sounds at a preset volume. To modify

@ Your receiver is preconfigured with either voice
these settings, use SRU.

The frequency of the voice message or sound depends on the specific
condition, the frequency is either once (when the condition first
occurs) or repeated (every 30 seconds for a set period of time).
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Data and Power Ports
The GRX1 has three ports (Figure 1-9):

¢ Power — rimmed in red; used to connect the receiver to an
external power source. The body of the connector on the
corresponding cable is red.

¢ Serial — rimmed in black; used for communication between
the receiver and an external device. The body of the
connector on the corresponding cable is black.

Power

Antenna
Port

Figure 1-9. GRX1 Ports — Power, Antenna, Serial

External Radio Antenna Connector

The UHF antennas connect to the external antenna connector under
the GRX1 housing (Figure 1-10 on page 1-21). Both modem antenna
types include support for a GSM/HSPA modem.

The modem antenna depends on the type of modem installed in the
receiver:
* UHF - Uses a BNC RF connection and comes in two
versions: 410-440MHz (p/n 30-070003-01) and 440-
470MHz (p/n 30-050503-01).
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UHF/GSM/HSPA Antenna

Figure 1-10. Modem Antenna

Connector

The bottom connector (Figure 1-11) connects the receiver to either a
standard 5/8" thread pole or to an adapter.

Bottom
, Connector

/

Figure 1-11. GRX1 Bottom Connector

SD/SDHC and SIM Card Slots

The SD/SDHC and SIM card slots reside under the battery near the
base of the dome.

The SD/SDHC card slot is located inside the battery pocket

(Figure 1-12 on page 1-22). Once installed, the SD/SDHC card can
be removed from the receiver. The data that resides on the SD/SDHC
card can be accessed by removing the card and using an external SD/
SDHC card reader, or by using SOKKIA software to download the
data via a serial or Bluetooth connection. A secure digital card can be
purchased from a local Sokkia dealer. The SD/SDHC card is
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available in FAT16 or FAT32 format so that the removable SD/
SDHC card is enabled for copying logging files directly to a PC.

The SIM card slot is located inside the battery pocket and allows a
standard SIM card to be installed in the receiver. Once installed, the
SIM card provides a unique identification for the receiver’s GSM/
HSPA module and enables the receiver’s GSM/HSPA functionality,
based on the subscribed services (the receiver board accesses the
GSM/HSPA module which accesses the SIM card). The SIM card
usually remains inside the receiver. The GSM/HSPA module with the
SIM card installed can be accessed via SRU for configuration
purposes. A SIM card can be purchased from a local cellular
provider.

SD/SDHC Card Slot
Figure 1-12. GRX1 Card Slot Example

To install the SIM card (Figure 1-13):

The SIM card must support Circuit Switched Data to communicate
directly between receivers. The SIM card must have GPRS or EDGE
support to communicate with a GPS Network IP address.

receivers, you must install a SIM card with a Circuit
Switch Data plan and have subscriptions to the
same service provider for proper data
communication.

@ For direct communication between Base and Rover
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Ensure the receiver is turned off.
Remove the battery.
If needed, snap the SIM card into its holder.

Carefully insert the holder, label side down, into the SIM card
slot located at the top of the battery pocket.

hall O

Figure 1-13. Install SIM Card

Once the receiver is turned on, the receiver board will detect the SIM
card, and it will be ready to use.

Cable

The GRX1 package includes a serial communication cable for
configuring the receiver. Table 1-3 describes the cable included in the
GRX1 package.

Table 1-3. GRX1 Package Cable

Cable Description Cable lllustration

Serial cable

Connects the receiver to an external
device (controller or computer) for
data transfer and receiver
configuration. Body of connector is
black.

Other Accessories
* Battery (BDC58) Li-ion Battery (4,300mAh, 7.2 VDC) x 2
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» Battery Charger (CDC68)

* Power Cable (73113/A/B/C) CDC68 to AC outlet/plug (region
specific)

* Manual CD

For more details on the accessories and package options available for
the GRX1, contact your local Sokkia dealer.

Optional Accessories

Sokkia offers a wide variety of accessories designed to extend job
reliability and efficiency. For more details on the optional accessories
available for GRX1, contact your local Sokkia dealer.

* Radio Antenna for Digital modem (30-050503-01 or
30-070003-01)

* 10cm spacer
¢ SD Card industrial model
* Measuring Tape (22-050902-1) 3.7m HI (Calibrated)

Option Authorization File (OAF)

Sokkia issues an Option Authorization File (OAF) to enable the
specific options that customers purchase. An Option Authorization
File allows customers to customize and configure the receiver
according to particular needs, thus only purchasing those options
needed.

Typically, all receivers ship with a temporary OAF that allows it to be
used for a predetermined period of time. When the receiver is
purchased, a new OAF permanently activates purchased options.
Receiver options remain intact when clearing the NVRAM or
resetting the receiver.

The OAF enables the following kinds of functions. For a complete list
of available options and details, visit the Sokkia website or consult a
Sokkia dealer.

* Type of signal (standard L.1; optional L2, GPS,/GLONASS)
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» Update rate standard 1Hz (optional 5Hz, 10Hz, or 20Hz)
RTK at 1Hz, 5SHz, 10Hz, and 20Hz

RTCM/CMR Input/Output

* Advanced multipath reduction (AMR)
SBAS(WAAS/EGNOS/MSAS)

» Receiver Autonomous Integrity Monitoring (RAIM)
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Notes:
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Chapter 2

Pre-survey
Preparation

Before beginning to survey with the GRX1 receiver, install the
following software, charge the battery and apply the following
configurations:

[0 Install receiver configuration software
See “Installing Sokkia Software” on page 2-2.

O Optional: install SD/SDHC card and/or SIM card
See “The SD/SDHC card slot” on page 1-21.

O Charge the Battery
See “Charging the Battery” on page 1-12.

[0 Configure the Bluetooth wireless technology module

See “Establishing a Wireless Connection” on page 2-5.

[0 Collect almanacs and ephemerides (after first-time configuration
activities as described in Chapter 3)

See “Collecting Almanacs and Ephemerides” on page 2-8.

This chapter also discusses connecting the receiver and a computer.
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Installing Sokkia Software

The Sokkia Receiver Utilities CD contains the SRU software
program from Sokkia used for configuring and maintaining the
receiver.

If you are installing SRU from the Sokkia Receiver Utilities CD,
insert the CD into the computer’s CD-ROM drive. If you are
downloading the program(s) from the website, extract the program
files into a folder on the hard drive.

The following sections describe installing this software, and other
sections throughout the manual describe using this software with the
receiver.

Installing SRU

SRU is a Windows® software application designed for configuring
GNSS receivers (Figure 2-1).

Computer requirements for the SRU are: Microsoft® Windows XP /
Vista/7 operating system and an RS-232C port or Bluetooth wireless
technology. Use SRU to correctly configure the receiver.

To install SRU:
1. Navigate to the SRU folder, and double-click SRU.zip.

2. Extract the SRU.exe file to the SRU folder.

3. Double-click SRU.exe to run the installer, and then follow the
on-screen instructions.

After installation, shortcuts on the desktop and in the Program menu

are created.

Wil
Figure 2-1. Desktop Shortcut — Sokkia Receiver Utilities

To install optional SD/SDHC card and the optional SIM card, see
“The SD/SDHC card slot” on page 1-21 for details.
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Charging the Battery See “Charging the Battery” on page 1-12 for
details.

Connecting the Receiver and a
Computer

SRU provides an interface for various configuration, monitoring, and
management functions for the receiver.

To configure, manage files, or maintain the receiver, connect the
receiver and a computer using one of the following methods and start
SRU:

* a Bluetooth-enabled external device (computer/controller)
» an RS232 serial cable and a computer/controller

Once a connection between the receiver and the computer/controller
has been established, you will be able to use SRU to configure the
receiver and its components, send commands to the receiver,
download files from the receiver's memory, upload new GNSS
firmware, upload an OAF and upload configuration files.

Establishing an RS232 Serial Cable
Connection

To establish a connection to a receiver, take the following steps:
1. Press the power button on the receiver and computer to turn them
on.

2. Using the RS232 serial cable, connect the serial port of the
computer (usually COM1) to the receiver’s serial port.

3. Run SRU.

Click Device » Application Mode » Receiver Managing
(Figure 2-2 on page 2-4).
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The computer/controller detects the device connected to the port.

FEY (=] © i
Device | View Help
Connect
Disconnect -
Setup Options
Application Mode ] Simple Terminal
Exit @ Receiver Managing
- Modem Managing
Firmware Tools TeETEVEr
Loader Settings
T i E
=3 ' "
| [ o -
|
Status File Explorer Modems
) Receiver Managing Mode a

Figure 2-2. Sokkia Receiver Utility (SRU) Dialog Box

Click Device » Connect. The Connection Parameters dialog box

displays (Figure 2-3). To establish a connection between the
computer/controller and the receiver, press the Connect button.
When detecting the receiver, the Detecting Receiver dialog box

displays.
- = r ~
fnd sRU = - - Gg Connection Param.... = | & ES
Device | View Help
= Connect Using
Disconnect [Serial Port v]
Setup Opticns e
ort Name
Application Mode ’
i - \\.\COM 17 (Prolific USB-to—Gerial Com E]
Exit 3
Firmware Tools Receiver Receiver Port
Load: Sett
oacer g [7] internal Modem
[ 5 =) s
.A_.‘ \g k‘; =9 [ser,{c -
|
Status File Explorer Modems
%) Receiver Managing Mode &

A

Figure 2-3. Connecting the Receiver and Computer Controller via RS232 Serial

6.

Cable

To close the connection between a receiver and the computer/

controller, click Device » Disconnect:

2-4
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& SRU to GRX1/U ID:EOOVUIMS... (=] B [
View Help

Connect

Disconnect ===
Setup Options
Application Mode B

B =

Firmware Tools Receiver
Loader Settings

k@ B

Status File Explorer Modems

) Receiver Managing Mode  [51COM17 &

Figure 2-4. Disconnect the Receiver From the Computer/Controller

check mark the External Receiver box in the
Connection Parameters dialog box (Figure 2-3 on
page 2-4).

@ To set a connection with the GRX1 receiver, do not

Establishing a Wireless Connection

The GRX1 receiver contains Bluetooth wireless technology that
allows file transfer and synchronization between the receiver and any
other external device that supports Bluetooth wireless technology; for
example, an SHC250, a computer with integrated Bluetooth or a
Bluetooth adapter installed.

Before establishing a connection to the receiver via Bluetooth, make
sure the module has Bluetooth power (Bluetooth Status LEDs blinks
blue). If these LEDs do not blink, you must activate the receiver
Bluetooth module by setting the connection between the computer
and the receiver using an RS-232 serial cable (follow steps 1-5
described in “Establishing an RS232 Serial Cable Connection” on
page 2-3).

To activate the Bluetooth module in the receive via Bluetooth:
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* Click on the Receiver Settings icon in the main window, then
click on the Bluetooth icon. The Bluetooth dialog box displays
(Figure 2-5 on page 2-6):

- - © Bluetooth [E=ETT)
='_ Farameters g Bluetooth
— — —_—
Receiver FIN: 0000 Bluetooth
Settings Address: 00:07:80:93: 1d:b0

' F/Vi Version: R AP THOR. AI (2.2.0 buik BluetOOth

[TIMultiplexing Mode I Dialog

[¥]Bluetoath Power
Receiver Settings

Icon

Figure 2-5. Bluetooth Receiver Settings

¢ Check mark the Bluetooth Power box, then click OK to activate
the receiver Bluetooth module.
Wireless status will be indicated by LED lights blinking blue

* Close the connection between a receiver and computer/controller

via RS-232 serial cable (see step 6 described in “Establishing an
RS232 Serial Cable Connection” on page 2-3).

To establish a connection to a receiver via Bluetooth, take the
following steps (Figure 2-6):

1. Press the Power buttons on the receiver and computer to turn
them on.
2. Run SRU.

3. Click Device » Application Mode » Receiver Managing
(Figure 2-6 on page 2-7):
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& sRu (=TT
[Dee] view e
Connae: 1 —
Disconnect ===
Setup Options
Application Mode » Sirnple Terminal
- % Receives Mansging
Madem Managing
Firmware Tools
Losder Settings
. =5 .
oA E
-
Status File Fxplorer  Mndems
4 Receiver Managing Mede &

Figure 2-6. Application Mode
4. Click Device » Connect.

6. Select the Browse ... button under Device Name.
This will initiate a BT discovery.

7. Select your device from the list of discovered devices and press

OK.

8. Press Connect (Figure 2-7).

bl sRU

Connedt

Discannect
Setup

Application Made

Fxit.
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Select Bluetooth from the Connect Using drop-down box.

\

> - r = N
5 Connection Param.‘.EIEIg ) Select Port =
Connect Using Friendly Name Physical Nar
[B‘umﬂm '] @ Pocket_pC 00:03:7a:6¢
1064-PP10039 00:07:80:5(
Device Name 1064-PP10010 00:07:30:5
655-PPO0D1 {00:07:80:93: 1d:b0) E] 559-PPO00L 00:07:80:9]
i cvp2zs1eM Foie@id3ibf
Receiver Port 4 S0DPTS00 cD:ch:38:a8,
[Tl External Receiver
serfa
« [ L3
l

Figure 2-7. Searching for Bluetooth Devices
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When detecting the receiver, the Detecting Receiver dialog box
displays.

@ Detecting Receiver

Cancel

Figure 2-8. Connecting Receiver and Computer/Controller via Bluetooth

9. To close the connection between the receiver and computer/
controller, click Device » Disconnect:

T 58U 1o GRXLU ID:E00VUIMS.. L] ) [
[Devicr | View Help
| s
| Disconnect
1
| Setup
Applcation Mode
Bt
Firmnware Teals Receiver
Loader Settings
A L(' ¥ lh
-
Status File Explarer Modems
Receiver Managing Made 551 COMLT &

Figure 2-9. Disconnect the Receiver from the Computer

Collecting Almanacs and
Ephemerides

Each satellite broadcasts a navigation message that includes the
ephemeris parameters of the satellite, the almanac, and various other
information. The ephemeris parameters describe the orbital motion of
the satellite and are used to predict its location/trajectory. The
almanac gives the approximate orbit (course) for the transmitting
satellite and all other satellites in the same system.

* GPS and GLONASS satellites broadcast ephemeris data
cyclically, with a period of 30 seconds.

* GPS satellites broadcast almanac data cyclically with a period of
12.5 minutes; GLONASS satellites broadcast almanac data
cyclically with a period of 2.5 minutes.

2-8 GRX1 Operator’s Manual



POWERUP Script

If the receiver has an almanac, you can considerably reduce the time
needed to search for and lock onto satellite signals.

The receiver regularly updates the almanac and ephemerides and
stores the most recent versions in its Non-Volatile Random Access
Memory (NVRAM).

Perform the following to collect Alamac and Ephemerides data:
1. Set up the receiver in a location with a clear view of the sky.

2. Turn on the receiver.

3. Wait for about 15 minutes while the receiver collects complete
almanac and ephemeris data from the satellites.

If 15 minutes have passed and the receiver does not
@ lock onto satellites, clear the NVRAM. See
“Clearing the NVRAM” on page 5-10 for details.

You will need to collect or update the almanac and ephemerides
under the following circumstances:

* If the receiver has been off for a long time

If the last known receiver position, stored in the NVRAM, is
different from the present position by several hundred kilometers

* After loading a new OAF
* After loading new GNSS firmware
* After clearing the NVRAM

POWERUP Script

The GRX1 POWERUP script feature uses specially formatted ASCII
text file (GRIL commands) that, once installed, enables the receiver
to perform a series of custom operations simply by pressing the
power button to turn on the receiver. i.e.:

» Automatically start static data logging to the SD/SDHC card.
* Automatically begin message output to the serial port.

* Automatically configure and start the RTK Base radio.
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Example For an easy “one button” base setup that is supported using
the POWERUP script:

* Mount the receiver on a tripod and press the power button

* During RTK base operation, the receiver will also automatically
collect raw measurement data to the SD/SDHC card.

* The receiver will automatically compute an averaged single-point
RTK base position.

After pressing the Power button, the operator may simply walk away.
No cabling, external data link, or data collector is required; work on
site can begin almost immediately.

POWERUP Script Requirements

After turning on the GRX1 receiver, the POWERUP script executes
when the receiver obtains valid position coordinates and the
following requirements are satisfied:

* The POWERUP script has been installed to receiver.
* The POWERUP script function setting is ON.
* The receiver is not starting by using the timer.

¢ There is no enabled session timer.

Installing the POWERUP Script

To install the POWERUP script onto the GRX1 receiver:

1. Copy the POWERUP script file “powerup.gcs” to the
“POWERUP” folder on the SD card.

Insert the SD card into the GRX1 receiver.
3. Perform a Factory Reset on the GRX1.

2-10 GRX1 Operator’s Manual



POWERUP Script

Once the installation is successful, the “powerup.gcs” file is
removed from the SD card.

be removed.

If there is an existing POWERUP script on the
GRX1, the new script file will override the existing
script.

@ If the file attribution is Read only, the file will not

Uninstalling the POWERUP Script

The POWERUP script can be uninstalled by using either of the
following two methods.

Method 1: Install an empty (no script) “powerup.gcs” file.

Method 2: Send the command “set,/ext/powerup/clear,y” using the
Terminal feature of SRU.

Editing the POWERUP Script

It is not possible to edit the existing POWERUP script in receiver
directly. Install (overwrite) the new POWERUP script after
modifying the script using SRU.

Enabling the POWERUP Script

It is necessary to enable the POWERUP script function in order to
allow the GRX1to execute the POWERUP script at every startup of
the receiver. Enable the POWERUP script by using any of the
following three methods.

Method 1: Send the terminal command “set,/ext/powerup/mode,on”.
Method 2: Perform a Factory Reset of the receiver.

Method 3: Enable using the SRU software.
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Disabling POWERUP Script

Disable the POWERUP script by using either of the following two
methods.

Method 1: Send the terminal command “set,/ext/powerup/mode,off”.

Method 2: Disable by using the SRU software.
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Chapter 3

GRX1 Configuration

Both Base and Rover receivers must be configured depending upon
the survey method needed.

When configuring receivers for RTK surveying, use the following
checklist to ensure the receivers are properly set up.

O perform pre-survey functions as described in Chapter 2.

O Configure one receiver as an RTK Base station and the other
receiver as an RTK Rover. See “Configuring the Receiver” on
page 3-16.

[J Set up the Base receiver over a known point to begin collecting
static observation data and transmitting corrections. Set up the
Rover receiver to begin collecting RTK data. See “GRX1
Receiver Setup” on page 4-1 for more information.

When configuring receivers for post-processing surveying, use
the following checklist to ensure the receivers are properly set up.

[J Perform pre-survey functions as described in Chapter 2.

O Configure one receiver as a Base station and the other receiver as
a Rover. See “Configuring the Receiver” on page 3-16.

[J Set up the Base receiver over a known point to begin collecting
static observation data. Set up the Rover receiver to begin
collecting static or kinematic observation data. See “GRX1
Receiver Setup” on page 4-1 for more information.

refer to the Spectrum Survey Field reference

@ For more information about kinematic observation,
manual.
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Managing the Radio Modem

Sokkia’s Receiver Utility (SRU) software supports configuration of
all radio modems that are embedded in GRX1 receivers. SRU
provides the following functions:

To configure the radio modem, have the following ready:
* PC running Windows XP/Vista/7 or newer
* SRU
* A Serial cable or Bluetooth capable device or PC.

Connecting with the Radio Modem

1. Turn on the receiver. Connect the computer and receiver using an
RS-232 cable or Bluetooth wireless technology.

2. Open SRU (Figure 3-1). Click Device » Application Mode »
Modem Managing. Then click Device » Connect.

sl SRU =
Device | View Help

Connect

Disconnect
Setup

Application Mode 2 Simple Terminal
Eit Receiver Managing
® Modem Managing

- Modem Managing Mode i.-‘

Figure 3-1. Modem Managing

3. Select the COM Port of the computer to which the receiver is
connected (Figure 3-2 on page 3-3).

4. Click OK.
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WL
!
!
!
!
!
W

I 2

wlolololololy

-

OK

Figure 3-2. Select COM Port
5. Check mark the Internal Modem box and select ser/c from the
drop-down menu (Figure 3-3).
All internal modems for GRX1 are on port C.
6. Click Connect.

-

-
dg Connection Param... = & ¥

Connect Using

[Serial Port - ]

Port Name

1\, \COM17 (Prolific USB-to-Serial Com D

Receiver Port
Internal Modem

[ser,{c hd

e A

Figure 3-3. Connection Parameters
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7. SRU will search through port speeds and flow settings until it
finds the modem (Figure 3-4).

@ Detectng Madem

Baud Rate: 115200, Bis: B
Stop Bits: 1, Parity: No parity

{ Cancel |}

Figure 3-4. Detecting Modem

‘When the modem is found, SRU will return to the main screen.

Topcon Digital UHF 1l Modem

The following describes specific parameters and functions for the
Topcon Digital UHF II modem.

General Information

The General page shows the modem model, and the product
identification information (Figure 3-5).

- % Topcon - Digital UHF II = | B i
A 1%
g —> Gereral | Settings | Functions | CCF Creator | DCF Creator |
b Manufacturer:  Topcon
Settings
Modem Model:  Digital UHF II

Settings Icon
Product identification information:

Digital UHF Il Radic Modem, Topcon Positioning Systems
Product 1D = 19

S/M = F33261134116

Hardware = Rev. D, BF 0.6, Flash 5T

Software = Version: 1.2b6 Mar 26 2012 14:31:12
BootLoader = Version: 2.2.1 Jun 24 2011

L] T

Figure 3-5. General Page

* Cell Info — press to view information on the cell module.
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Modem Settings

The Settings page allows setting values for parameters of the
connected modem (Figure 3-6).

% Topcon - Digital UHF II = | E | )
| General | Settings | Functions | CCF Creator | DCF Creator |
Parameters List k] | e
Property Value i
%2 General
# Mode Cell
“ Baud Rate, baud 115200
“ Flow Control NOME
#* Fimware Mode Factory E
“1% Radio
“ Frequency. MHz
“ Protocol PDL Recsiver
“# Modulation GMSK
“ Spacing. kHz 25
* Power, mW 10
# Scrambler Enable
¥ FEC Enable
“% Satel
# FCS Net ID, hex 10 v

Figure 3-6. Settings Page

The Settings page displays general communication parameters, and
parameters specific for the modem. To change any editable
parameter, click on the Value field of the highlighted parameter and
select a desired value from the drop-down list appear.

¢ General parameters:

— Mode: selects Radio or Cell to use for communication (the
UHF or GSM/CDMA band, respectively).

— Baud Rate, baud.: selects a baud rate for the modem’s serial
port.

— Flow Control: enables hardware flow control.
® Radio parameters:

— Frequency, MHz: assigns an operating channel to the radio
modem. Select the desired frequency from the list.

— Protocol: sets the protocol for data receiving/transmitting.
— Modulation: selects a modulation type for the radio modem.
— Spacing, kHz: selects the channel spacing.

— Power, mW: sets the transmission power for the base radio.
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— Scrambler: when enabled, provides more robust data
communication over high interference areas.

— FEC: (Forward Error Correction) Enable to maximize data
communication. The rover radio modem has the capability to
check and correct transmission errors (if any) in an incoming
data stream.

® Satel parameters:

— FCS Net ID, hex: Configures network ID.

— Address Receiving: Configures address receiving.

— Address Transmission: Configures address transmission.

— RX Address, hex: Configures the receiving primary address.

— TX Address, hex: Configures the transmission primary
address.

Table 3-1 displays a list of possible values of the parameters. Default
values are shown in bold.

Table 3-1. Possible Values of Parameters

Parameter Name Values

Mode Radio
Cell

Baud Rate, baud 19200
38400
57600
115200

Flow Control NONE
RTC/CTS

Frequency, MHz Carrier frequency displayed in MHz

Protocol PDL Receiver
PDL Transmitter
PDL Repeater
Satel Receiver
Satel Transmitter
Satel Repeater
Satel FCS Receiver

Modulation GMSK - Minimal Shift Keying with Gaussian
Filtering
4FSK - Four Level Frequency Shift Keying
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Table 3-1. Possible Values of Parameters

Parameter Name Values
Spacing, kHz 12.5
20
25
Power 100, 250, 500, or 1000 mW
Scrambler Disable
Enable
FEC Disable
Enable
FCS Net ID [0x0000...0xFFFF]
Default value: 0x0010
Address Receiving Off
On
Address Transmission | Off
On
RX Address, hex [0x0000...0xFFFF]
Default value: 0x0000
TX Address, hex [0x0000...0xFFFF]
Default value: 0x0000

Link Rate dependence on the modulation and the space value is
presented in Table 3-2.
Table 3-2. Link Rate vs. Modulation and Space

SpaceValues | 12.5kHz [20kHz |25kHz
Modulation
GMSK Minimal Shift Keying with 4.8 kbps | 4.8 kbps |9.6 kbps
Gaussian Filtering
4FSK Four Level Frequency Shift 9.6 kbps | 9.6 kbps | 19.2 kbps
Keying
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Modem Functions

The Functions page allows invoking modem’s functions (Figure 3-
7).

%, Topcon - Digital UHF II = | E S

| General | Settings | Functions | CCF Creator | DCF Creator |
Function:

[ «Setect Functions BiE=

Input Parameters
Property Value

Property Valus

=

Figure 3-7. Topcon Digital UHF Il Functions Page
The following functions are available for executing in this modem:

* BootConfiguration — This command is intended to reboot the
unit using selected user settings. Two options are available, to use
the default user settings defined by dealer or to use the settings
defined by the end-user.

* Factory Reset — Resets all the parameters to their default values.

* UploadFile — Intended to upload Country Configuration (CCF)
or Dealer Configuration (DCF) files.

NOTICE:

Please be aware that Digital UHF II modem supports a wide UHF
frequency range of 400-470 MHz, and is delivered to you in a default
factory configuration.

Before operating receiver equipped with Digital UHF Il radio, you
are required to upload the frequencies that you will need for radio
communication in your specific region. UHF frequencies in your
region may be licensed or unlicensed, but are always subject to some
level of restriction within the overall 400-470 MHz range. Your
receiver should come pre-loaded with the DCF file and proper
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frequency options from your dealer. If your receiver is not loaded
with the specific UHF frequencies, please contact your local dealer
and request a DCF file containing licensed UHF frequencies and
channel spacings.

To load a DCEF file:

1.
2.

Copy the DCEF file to your PC.

Turn on the receiver. Connect the computer and receiver using an
RS-232 cable or Bluetooth wireless technology.

Open TRU and connect to the Radio modem (see “Connecting
with the Radio Modem” on page 3-2)

Click on the Settings icon to open the Digital UHF 11 Settings
screen, then select the Functions tab

Topcon - Digital UHE T = | B

General | Settings | Functions
Function
UploadFile > || Execute
Input Faramaters
Propery Value
¥ Fie
¥ Type

Output Farameters

Property Value

=}

Figure 3-8. Topcon Digital UHF Functions Page

In the Function list, select Upload File.

Under Input Parameters, click the Value field for the File
property

Select the DCEF file saved to your PC

Click the Execute button

After the DCF file is loaded, open the Settings tab to ensure the
frequencies are correctly loaded and available for use.
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It is mandatory to load a valid DCF configuration before using the
product. Failure to apply this procedure may result in non-operation
of the Digital UHF II radio, or breach of local regulatory laws that
govern radio communications. If you have further questions or
concerns, please contact Topcon's Technical Support Group (TTS).

Satel Modem

The following describes specific parameters and functions for a Satel
modem.

General Information

The General tab shows the modem model and the product
identification information (Figure 3-9).

.
Satel - SATELLINE-2AS [E=mE=R

General | Settings | Functions

>

Settings Manufacturer. Satel

Modem Model SATELLINE-3AS

Product identification information:
3ASOEM1I1

[ Celifo |
[ B |

Figure 3-9. Satel General Page

* Cell Info - press to view information on the cell module.

Modem Settings

The Settings tab shows: general information about the modem type,
software and hardware revisions, product code and serial number, and
displays a list of settings for the modem (“Managing the Radio
Modem” on page 3-2).
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The UHF Satel radio modem offers a transmitter/receiver/repeater
functionality with a maximum 1'W power output for data
transmission. The frequency range of the modem depends on the
country in which the receiver is used.

sufficient for most jobsites. Changing these settings
can affect the operation of the radio modem and
communication between receivers.

% The default settings for radio configuration are

The settings can be read-only (marked by the [:7] icon) or changeable
(marked by the [#] icon). Clicking on the corresponding line in the
Value column of any editable parameter opens a field to enter or
select from the drop-down list a needed value (see Figure 3-10 on
page 3-12).
* General parameters:

— Model: the product model identification text.

— HardwareVersion: the hardware revision of the modem.

— FirmwareVersion: the firmware version of the modem.

— Product Code: specifies the product code.

— Serial Number: specifies the serial number unique for the
modem.

— Baud Rate, baud: specifies the baud rate of the modem's
serial port connected internally with the receiver's serial port,
by default with hardware flow control.
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-
i1 Satel - SATELLINE-3AS

General | Settings | Functions

Parameters List

=1

Property
“¥ General
=¥ Modsl
¥ Hardware Version
¥ Fimware Version
¥ Product Code
¥ Serial Number
 Baud Rate, baud
“i% Radio
W Frequency, MHz
“ Protocal
&¥ Spacing, kHz
¥ Satel FEC
* Signal Threshold, dBm
“ Power. mW
¥ Repeater

Value

3ASOEM11
HW:OEM11Rc
Va3s
05-050916-13
054742006
38400

468.20000
Satel 3A5
125
Disable
-114

1000

No

n

Figure 3-10. Satel Settings Page

* Radio parameters:

— Frequency, MHz: the operating frequency used for data

transmission and reception.

— Protocol: selects a protocol and a modulation type.

— Spacing, kHz: displays the channel spacing. This is

determined by the hardware.

— Satel FEC: Forward Error Correction technique to maximize

data communication. The rover radio modem has the
capability to check and correct transmission errors (if any) in
an incoming data stream.

— Power, mW: sets the appropriate level of output power.

— Repeater: Enables/Disables repeater function.
— TX Delay, ms: Specifies TX delay.
— TX Addressing: Specifies TX address mode.
— TX Address, hex: Specifies primary transmit address.
— RX Addressing: Specifies RX address mode.
— RX Address, hex - Specifies primary receive address.
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* FCS parameters:

— FCS Mode: Allows enabling Free Channel Scan mode.
In free channel scan mode, the Base radio modem will
regularly scan the current operating frequency to determine
the degree of a radio noise (interference). Should the level of
noise on the current operating frequency be greater than the
threshold specified in the Signal Threshold field, the
transmitter will stop broadcasting and switch to the next
frequency.

— Net ID: sets Free Channel Scan Net ID.

interference if a jobsite has more than one set of
receivers. In this case, enter a different net ID for
each set of receivers.

% Occasionally, the receivers may encounter

Table 3-3 displays a list of possible values of the parameters. Default
values are shown in bold.

Table 3-3. Possible Values of Parameters

Parameter Name Values
Baud Rate, baud 19200
38400
Protocol Satel 3AS
PDL 4FSK
PDL GMSK w/EOT *

* - PDL GMSK w/EOT protocol is supported by
firmware 3.44n or later.

Spacing, kHz 12.5
20
25

The value is determined by the hardware

Satel FEC Disable
Enable
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Table 3-3. Possible Values of Parameters (Continued)

Parameter Name Values
Power, mW 100
200
500
1000
Repeater No
Yes
TX Addressing Disable
Enable

TX Address, hex

0000h - FFFFh
Default: 0000h

RX Addressing

Disable
Enable

RX Address, hex

0000h - FFFFh
Default 0000h

FCS

OFF

TX Master

RX Slave

RX/TX Repeater

TX Master + Repeater
RX Slave + Repeater

Net ID, hex

0000h - FFFFh
Default: 0010h

To properly communicate, the Base and Rover
radios require the same settings for Current
Frequency, FCS and Net ID.
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Modem Functions

The Functions page allows invoking modem’s functions (Figure 3-
11).

{ Satel - SATELLINE-3AS = | 5] |-,

Function:
[<Select Function Bl Beecute

Input P
Property Value

Qutput Parameters:

Property Value

Figure 3-11. Functions page

The following functions are available for executing in this modem:

* AddChannel: This command is intended to add an operating
frequency from a list defined by the dealer to the list defined by
the user.

* DeleteAllChannel: Intended to delete all operating frequencies
from the list defined by the user.

* FactoryReset: Resets all the parameters to their default values.
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Configuring the Receiver

The GRX1 can be configured in several ways for collecting data for
RTK or post-processing.

¢ A static Base station collects measurement information and saves
this data to its internal memory.

¢ An RTK Base station collects measurement information,
determines differential corrections, and transmits them to the
RTK Rover(s).

¢ A static Rover collects observation data from the same satellites
during the same time interval as the static Base station.

* An RTK Rover collects measurement information and accepts
corrections from the RTK Base station to compute its relative
position.

To configure, manage files, or maintain the receiver, connect the
receiver and a computer using one of the following methods, and start
SRU:

* use a Bluetooth-enabled external device (computer)
e use an RS232 serial cable

SRU configures the various parts of the receiver, saving the settings
in the receiver’s memory.

Once you have established a connection between the receiver and the
computer, you can:

* configure the receiver and its components

* send commands to the receiver

» download files from the receiver’s memory

* load a new OAF and other configuration files to a receiver

Once an SRU connection with the receiver has been established, all
icons on the screen become active (Figure 3-12 on page 3-17).
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-
k= SRU

Device View Help

Terminal

Firmware
Loader

)

hl
-
Status

d

Information Options
4 =
Tools Receiver
Settings
- -..lf kP .
[ s
File Explorer Modems

4 Receiver Managing Mode

@

Figure 3-12. SRU Connection Established

Satel Modem

1. Click on the Receiver Settings icon to open the Receiver
Settings, then use the Receiver Settings options to configure the
connected receiver (Figure 3-13).

Receiver
Settings

—

Receiver Settings Icon

\

- -
B SRU to GRXL/U ID:EOOVUL.. |- = |/ b

Device View Help
€ 4
9 T 1
Back Tracking Positioning
= e —
! H E“ @
L | »
Perts Power Auto Seed
Volume Control Bluetooth
) Receiver Managing Mode (53 COM17 fb

Figure 3-13. Receiver Settings

2. Click on the Tracking icon (Figure 3-14 on page 3-18).
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3. On the Antenna tab, set the antenna type to be used with the
connected receiver.

i‘-‘f‘b ). Tracking Options = | B |t
' } Antenna |Obs | Adv | Msint
Trecking GNSS Antenna
1 @ Curmrent Input:
Tracking Icon @ Intemal
Extemal Intemal
Auto
[ OK ] [ Cancel

Figure 3-14. Set Antenna Parameters

4. Click on the (Obs)ervation tab (Figure 3-15 on page 3-19) to set
the following parameters, then press OK to save.

¢ Elevation mask position computation:
—Set to 13°

® PDOP mask for position computation panel:
— enter a PDOP mask value.
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%% Tracking Options

|Arrtenna| Obs |Ad\r IMsint |
Elevation Mask, deg

Satellites Tracking: 5
Position Computation: 13
RTK Computation: 10

PDOP Mask
Position Computation:

30

RTK Computation:
5

[ ok ][ canca |

Figure 3-15. Configure Receiver Positioning — Elevation Mask

5. Click the Advanced tab to set the following parameters, then
press OK (Figure 3-16 on page 3-20) to save.

* Anti-jamming — if available, enables suppression of narrow-

band interference for GPS, GLONASS, L1, and L2 signals,
for auto-detected or manually selected bands affected by
interference if available for the connected receiver.

C/A code multipath reduction — enables the use of a special
signal processing technique for reduction of C/A code phase
multipath.

C/A carrier phase multipath reduction — enables the use of a
special signal processing technique for reduction of C/A
carrier phase multipath.

Cinderella — enables the Cinderella option which sets all
receiver options to their maximum allowable values for 24
hours every other Tuesday at GPS midnight.

Static Co-Op tracking — allows only the static receiver to use
satellites with lower signal-to-noise ratios. Use only if the
receiver’s antenna remains completely stationary throughout
the survey. Any movement may result in losing the satellite
lock.
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% Tracking Options | = | B iz-]

|Antenna|0b5 |AC|V |Msint|

Antifamming:

C/A code muttipath reduction

[T C/A camier phase multipath reduction
[ Cinderella

[ Static Co-Op tracking

L5 tracking

[ ok ][ canca |

h

Figure 3-16. Configure Advanced Parameters

Configuring the Base

In addition to the settings from the previous section, the following
Base configurations are recommended for the most common
applications; however, you can select configuration parameters as
needed for your particular jobsite

1. For the Base receiver, click the Auto Seed icon on the SRU
dialog box (Figure 3-13 on page 3-17). The Auto Seed dialog box
displays to set the following parameters (Figure 3-17 on page 3-
21), then press OK to save.

e Enable Auto Seed — enables the Auto-Seed functionality for
the base receiver.

Auto-seed feature will provide users the ability to quickly
setup and begin RTK operations without using an external
interface to localize the base receiver. The user will simply
set up over a mark and power up. The base receiver will
automatically select a new position gathered by autonomous
averaging and save it for later re-occupation.

* Maximum distance — selects a point from positions stored in
memory if the point has been previously occupied and the
receiver position falls within proper tolerance.
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* Enable averaging mode — check mark this box to enable
averaging autonomous positions for a occupation point with
the interval set in the Position averaging interval field below
in seconds.

[ @ Auto Seed o | B S
® —
Enable Auto Seed

Auto Seed

Maximum distance:

Auto Seed Icon 0
m

Enable averaging mode

Position averaaing interval:
180 [

’ View the point list ]

[ OK l ’ Cancel l

.

Figure 3-17. Base Configuration

* View the point list — press to open a list of previous
occupations saved in the receiver memory.

The Auto Seed, Point List contains information about all
occupations which stored in the receiver memory: names,
date and time, coordinates of phase center and/or antenna
reference point, whether the point was auto determined and
protected from deleting. For details on configuring the Auto
Seed functionality, refer to the SRU Reference Manual.
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Configuring the Rover

In addition to the settings outlined in the Receiver configuration
section, the following Rover configurations are recommended for the
most common applications; however, you can select configuration
parameters as needed for your particular jobsite.

the SRU Reference Manual.

@ Do not make other changes without first consulting

Connect the receiver and computer as described in “Connecting the
Receiver and a Computer” on page 2-3.

1.

For the Rover receiver, click the Positioning icon on the SRU
dialog box (Figure 3-13 on page 3-17).

On the Positioning dialog box, set the following parameters on
the General tab, then press OK (Figure 3-18 on page 3-23) to
save.

* Positioning Mode — For post-processed surveys, select
Standalone; for RTK surveys, select RTK float or RTK fixed.

* Enable Solutions — select solutions used in position
computation.

— Standalone: where the receiver computes 3D coordinates
in autonomous mode without using differential
corrections.

— Code Differential: where the Rover receiver computes the
current relative coordinate in differential mode using
only pseudo ranges.

— RTK Float: where the Rover receiver computes the
current relative coordinates in differential mode using
both pseudo ranges and phases; however, with a float
solution, the phase ambiguity is not a fixed integer
number and the “float” estimate is used instead.
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— RTK Fixed: where the Rover receiver computes current
relative coordinates, with ambiguity fixing, in differential

mode.

-~

1 f = | ] |-,

3 1 Positioning

b 'I Gereral |GPS | GLONASS | Galleo [ SBAS [azss [1[«]»
ositioning

Positioning Mode DION
() Standalone Off
[ | Code Differertial Local
() RTK Foat
@ RTK Fixed

Positioning Icon

Smooth

Enable Solutions
Standalone
[ Code Differential
RTK Float
RTK Fixed

[ ok ][ Ccancel

\

Figure 3-18. Rover Configuration
* DION solutions — select one of the following options:
— Off: disables the DION engine.
— Local: provides precise positioning with respect to a

starting point.
— Smooth: provides smoothed estimates of absolute
positions using refined delta positions from carrier phase

processing.
2. For RTK surveys, click the Ports icon on the SRU dialog box
(Figure 3-13 on page 3-17), set the following port parameters for

the serial port.

P/N 7010-0965 3-23



GRX1 Configuration

= g I5A dev/ser/a Settings | [ e -
_> General | Seral
Ports Input Mode: cmd
Ports Icon Output Mode: [None -
Pericd, s:

9| 8|

| Messages |
9| 8|

[ ok ][ cancel

Figure 3-19. Ports Configuration

@ For post-processed surveys, keep the default values
for these parameters.

3. Press OK to save the settings and close the dialog box.

Once the receiver is configured, the configuration will remain
until you change it using SRU, by resetting the parameters to
default values or by clearing the NVRAM. For more details on
the settings available for configuring receivers, refer to the SRU
Reference Manual.

4. For RTK Rover receivers, click the Status icon on the SRU
dialog box (Figure 3-13 on page 3-17), to ensure the receiver
obtains differential corrections. Usually, the receiver will start to
output the coordinates of the antenna’s phase center along with
the solution type within 10-30 seconds. However, spread
spectrum radios and GSM phones may take as long as 60 seconds
to synchronize.

The Data Link tab (Figure 3-20 on page 3-25) reflects the status
of the received differential messages and contains the following
information:

* Data link quality in percentage

» Time (in seconds) elapsed since the last received message
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* Total number of received correct messages (dependent on the
message type received)

* Total number of received corrupt messages (dependent on the
message type received)

If, for some reason, the receiver is not receiving differential
corrections, or if none of the ports has been configured to receive
differential corrections, the Link Quality field will be empty or
show 0%.

& Status GRXL/U DEOOVUIMSHAW L= B e

» —
Position | Data Link | SV List | Sky Plot | Scatter | Postior| [
Status

Data Link 1

Status Icon Data Link ldentifier serfa
Decoder RTCM 3.0
Ref Station oooo
Link Quality 100%
DLink Delay 1
Received Messages 380
Corrupt Messages 0

Close

%

Figure 3-20. Status — Data Link

5. Continue with other configuration activities or click Device »
Disconnect.

6. Click Device » Exit to quit SRU.
Disconnecting before exiting ensures proper port management.

eliminate possible conflicts with the management of

@ Disconnect the receiver from SRU before exiting to
the computer’s serial ports.

For more information on any of the procedures in this section or on
SRU, refer to the SRU Reference Manual (PN/7010-0980).
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Sokkia’s field survey software, Spectrum Survey Field, also has the
ability to configure Sokkia receivers. Refer to the Spectrum Survey
Field Reference Manual or the Spectrum Survey Field User’s
Manual for details.

GRX1 Operator’s Manual
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Chapter 4

GRX1 Receiver Setup

After receiver survey configuration, set up each receiver, measure its
height, and begin surveying. The LED Display Panel provides quick
access for logging data, changing receiver modes, and viewing
general data logging and satellite information during a survey.

Receiver Setup

A typical GPS survey system consists of a Base station set up over a
known point and a Rover receiver set up to be a mobile data collector.
After setting up the Base and Rover receivers, the antenna height
must be measured.

Before collecting data, make sure the Base and Rover receivers
contain a current almanac and current ephemeris data (see “Collecting
Almanacs and Ephemerides” on page 2-8).

Step 1: Set up the Receivers

The Base station must be set up, logging data, and correction data
before setting up the Rover receiver. Receiver setup for either post-
processing or RTK surveys is the same.

O set up the Base station and its components.
See “To set up the Base receiver” below for details.
O set up the Rover receiver.

See “To set up the Rover receiver” on page 4-3 for details.

To set up the Base receiver (Figure 4-1 on page 4-2), do the
following:

1. Install a tripod over a known control point.
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2. Secure the universal tribrach to the tripod. Place the tribrach
adapter on the tribrach and tighten the screws.

Insert the horizontal spacer into the precision tribrach adapter.
Attach the 10cm spacer to the horizontal spacer.

Attach the GRX1 receiver to the 10cm spacer.

Carefully level the tripod and tighten the screws.

N AW

Attach any other accessories as needed (for example, a backup
power supply).

@ GRX1 Receiver
S 2
ﬂ 10cm Spacer
4
L 2

Horizontal Spacer

Tribrach Adapter (Precision)

Universal Tribrach

Figure 4-1. Install Tripod and Receiver over Control Point
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To set up the Rover receiver (Figure 4-2):

the antenna/receiver does not move during data

@ Use a bipod during post-process surveys to ensure
logging.

Attach the GRX1 receiver to the top of the rover pole with
5/87x11” thread. Make sure that the receiver is securely affixed to the
top of the rover pole.

g ™\ GRX1 Receiver

5/8 Inch Screw

Lock

Figure 4-2. Connect GRX1 Receiver to Bipod

Step 2: Measure Antenna Height

The location of the antenna relative to the point being measured is
very important for both surveys in which the elevation of the points is
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important and in surveys for horizontal location only. Horizontal
surveys are often larger in area than can reliably fit on a flat plane,
therefore, the antenna adjustment must be done in three dimensions
and then projected onto a two dimensional plane.

The receiver calculates the coordinates of the antenna’s phase center.
To determine the coordinates of the station marker, specify the
following:

* Measured height of the antenna above the station marker
* Method of measuring the antenna height
* Model of the antenna used

Antennas have two types of measurements:

¢ Vertical — measured from the marker to the antenna reference
point (ARP) located on the bottom of the receiver at the base of
the mounting threads.

 Slant — measured from the marker to the lower edge of the
antenna slant height measure mark (SHMM) located on both end
panels of the receiver.

The surveying point that GPS/GLONASS uses to measure satellite
systems is called the ‘“Phase Center” of the antenna. The antenna
Phase Center is analogous to the calibrated point to which a distance
meter measures inside of a prism; i.e. it cannot be directly measured
to in the field. For precision Sokkia GPS/GLONASS antennas — such
as the one inside the GRX1 — the antenna Phase Center must be
modeled using a detailed calibration in order to achieved optimal
survey results. This model information consists of phase center offset
(PCO) and phase center variation (PCV) components, and is applied
internally by field software such as Spectrum Survey Field for RTK
operations, and by Spectrum Survey Office software for post-mission

operationsl .
The only information that must be supplied from field observations

when using GRX1 is i) the measured instrument height, and ii) the
measurement method used. The Sokkia field and office software will

1. This antenna calibration information (PCO and PCV data) does not
need to be entered in the field.
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automatically make all antenna Phase Center adjustmentsl that are
necessary to deliver properly referenced marker coordinates.

1.

Measure the antenna height above the control point or marker,
either the slant height or the vertical height.

You may either measure the vertical height to the Antenna
Reference Point (ARP) located at the bottom of the GRX1, or
measure the slant height to the Slant Height Measurement Mark
(SHMM) on the side of the enclosure (Figure 4-3 on page 4-6).

Record the antenna height, points name, and start time in the field
notes.

1. Advanced users may choose to configure the applied Phase Center

model that is used for the GRX1, and this may be done using Sokkia
application software such as Spectrum Survey Field and Spectrum
Survey Office. This additional step is optional since Sokkia software
automatically contains antenna Phase Center models for all Sokkia
products, including the GRX1.

Instead of Sokkia's supplied default Phase Center model for GRX1,
alternate or updated Phase Center models (with PCO and PCV data)
may be obtained from various government or private calibration
services. The most widely recognized of these services are the U.S.
National Geodetic Survey (NGS), the International GNSS Service
(IGS), and Geo++ GmbH of Germany. The default Phase Center
models supplied with Sokkia products are typically based on absolute
calibration models from NGS.
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Figure 4-3. Antenna Height Measurement Points
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Static Surveying for Base
Stations

Static surveying is the classic survey method, well suited for all kinds
of baselines (short, medium, long). At least two receiver antennas,
plumbed over survey marks, simultaneously collect raw data at each
end of a baseline during a certain period of time. These two receivers
track four or more common satellites, have a common data logging
rate (5-30 seconds), and the same elevation mask angles. The length
of the observation sessions can vary from a few minutes to several
hours. The optimal observation session length depends on the
surveyor’s experience as well as the following factors:

* The length of the baseline measured

* The number of satellites in view

* The satellite geometry (DOP)

* The antenna’s location

* The ionospheric activity level

* The types of receivers used

* The accuracy requirements

* The necessity of resolving carrier phase ambiguities

Generally, single-frequency receivers are used for baselines whose
lengths do not exceed 10 kilometers (6 miles). For baselines of 15
kilometers or greater, use dual-frequency receivers.

Dual-frequency receivers have two major benefits. First, dual-
frequency receivers can estimate and remove almost all ionospheric
effect from the code and carrier phase measurements, providing much
greater accuracy than single-frequency receivers over long baselines
or during ionospheric storms. Secondly, dual-frequency receivers
need less observation time to reach the required accuracy.

After the survey completes, data the receivers collect can be
downloaded onto a computer and processed using post-processing
software (for example, Spectrum Survey Field).
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Kinematic (Stop & Go)
Surveying for Rover Stations

For kinematic stop and go survey, refer to the Spectrum Survey Field
Reference Manual.

4-8 GRX1 Operator’s Manual



Chapter 5

Receiver and File
Maintenance

If post-processing the data after completing a survey, the data in the
receiver’s memory needs to download to a computer. Downloading
and deleting files prepares the receiver’s memory for the next survey.
Occasionally, the receiver’s NVRAM may need to be cleared to
eliminate communication or tracking problems.

As project expectations expand, the receiver’s OAF may need to be
updated to provide expanded operation and functionality. The various
boards inside the receiver (GPS, power, modem, and Bluetooth)
require firmware to properly operate and provide appropriate
functionality. Load GNSS firmware updates into the receiver right
after Sokkia releases them to ensure the receiver operates at its full
potential.

Downloading Files to a
Computer

There are several ways to download files to the computer.

Downloading Files via SRU

SRU allows you to download files to your computer and to delete
files from the receiver.

1. Connect your receiver and computer. Open SRU See
“Connecting the Receiver and a Computer” on page 2-3 for this
procedure.
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Click on the File Explorer icon in the main window. The File
Explorer dialog box displays all logged raw data files

(Figure 5-1).

File Explorer

File Explorer Icon

\cy File Explorer = | B )
Files |Logs | MINTER [ AFRM
Name Size, B Date
[#log20120524.. 3245895  5/24/2012 10:57:59 Ph
[#)log20120615, 105192 6/15/2012 6:55:14 PN
log20120615.. 89507  B/15/2012 5:48:44 PN
[#log20120615, 468779 6/15/20125:39:13 PN
[#log20120675.. 96368 6/19/20128:13.09 PN
[#log20120608. 152633 6/8/201211:02:52 PN
< m ] »

Figure 5-1. File Explorer Dialog Window

To save a highlighted file into the computer, right-click and select
Download from the pop-up menu. In the Save As dialog box
navigate to or create a folder in which to download and store file

(Figure 5-2).

Press Save to download the file.

&4 File Explorer =B8] X Browse For Folder ==
Fies |Logs | MINTER | AFRM Select Folder
Name Size. B Date
[#log20120805 1924328 9/5/2012 105415 PN B Boez o
[#]1og20120506 2,068,600 /6/2012 7-15:45 PM
log20120906.. 10,229,345 9/6/2012 5:22:57 PM ce69f42612732744281e40FcIdb2fe
[2log20120905.. 288,197 9/5/2012 10:16:50 PN Config.Msi =
3712994 9/6/2012 8:05:11 PM > B Data H
601,897 9/12/2012411:21 FN s B del B
[2log20120872.. 4694 9/12/2012 6:29.06 N
[} log20120972.. 76857 912/2012 6:30:24 PN > @1 Decuments and Settings
> Downloads
. Project1153a
> Drivers
< n | 3 > Intel
> 1) MosUPPSP .
ol =
\
Figure 5-2. Download a File

5. When the process of transferring the file(s) from the receiver to
the computer begins, the Downloading window (Figure 5-3 on
page 5-3) displays the download in progress.
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Other ways to download files to a computer includes:

Deleting Files From the Receiver
Using SRU

Downloading Files to a Computer

8 ' Downloading

= |3 &

Copying the file Tog20120905_153306" to
"C:\Downloads\Project 1153a"

Total Progress:

Time 00:00:43

Remaining: 00:01:59
Cancel

Figure 5-3. Downloading in Progress

* Downloading files directly to Spectrum Survey Office (SSO).

* They could also be transferred by removing the SD card and
using a SD card reader connect to a PC to transfer the files.

To delete files from your receiver, perform steps land 2 as described

in “Downloading Files to a Computer” on page 5-1, then:

1.

P/N 7010-0965

Highlight the desired file in the File Explorer dialog box, right
click, and select Delete from the pop up menu.
Press Ok to delete the file.

On the SRU confirmation screen, press Yes to confirm the
deletion (Figure 5-4 on page 5-4).
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4 Fie Explorer o [ 12 i |

Fies | Logs | MENTER | AFRM
See B

1.524,320
2/068,600
10,329,946

62012 5: 7
o — Relresh e Centiren deletion.

(WJinga0120812
Wing20120812
WHiogana0m12 Duwndoad [ys | Ho

Uglad

Delete

Imitialize File System

File System Info

Made of speration . i

Figure 5-4. Deletion of a File

Deleting Files Using the Power
Button

All files stored on the SD/SDHC card are deleted when the power
button is pressed for 20 seconds and released in less than 25 seconds
(see erase memory description in Table 1-2 on page 1-18).

Managing Receiver Memory

When using the receiver in static or dynamic applications, you may
need to know the amount of memory the receiver’s log file occupies.
The specific memory size depends on the type of data being recorded.
Use the formulas below to compute the approximate size of the
receiver’s log files. These equations are based on the default set of
messages.

* SS — the estimated size of one epoch of raw data in the receiver’s
log file (expressed in bytes).

* N - the number of observed satellites per epoch.
When recording only L1 data:

SS =183 + 22*N
When recording L1 and L2 data:

SS =230 + 44*N
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Managing Receiver Options
The Option Authorization File (OAF) enables certain functions,
features, and options in the receiver, such as the following:
* the type of signal (L1, L1/L2, and so on) the receiver processes
* the amount of data the receiver stores in the memory
* the rate at which data is transmitted or received

For a complete list of available options and details, consult with your
Sokkia dealer.

Checking the Receiver’s OAF

Use SRU to view receiver status options.

1. Connect your receiver to the computer. Open SRU. See
“Connecting the Receiver and a Computer” on page 2-3 for this
procedure.

2. Click on the Options icon in the main window (Figure 5-5).

The Receiver Options dialog box (Figure 5-5) displays the
current authorization options and uploads new ones.

& sRU (=[5
Device View Help ™ Receiver Options Y
= — Dption Name Curent Purchased  Leaced  Dip.Dste *
H % === Eers e Vs ™
L
[AETE s e Mo
Terminal Information Options ] Galieu Mo No N
—’ aju1 ex Yes ™
1 [&3 es Yes Ne
S L —t & s LS Traceg Mot spported  ho o
3 # = 18] onderets ree es e
f SlpostonUpdstemiate, iz 10 0 Disabled
Firmware Tools Receiver w Dats Update Rate, bz 10 1] Disabled
Loader Settings =] Code ferental Base Yes Yes N
] Code DFferentsl Rover res res o
- 3 s fes o
A‘ L" - A 0 0 Disabled
- Hemory, MB Natmgpperted 2,176 ]
Status File Explorer Modems o Tracking fes tes Ho
PR Taning Sagnal Docble Devhle Na
[E] vent Mariers Ha e N
| Refresh Lipsad 08 | Sawe be Fle |

) Receiver Managing Mode @ T

Figure 5-5. Checking Receiver Options
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Uploading an OAF

OAF files comes from Sokkia dealers. For any OAF related
questions, e-mail Sokkia at options @sokkia.com and include the
receiver’s ID number (see the bottom of the receiver for the ID).

1. To load a new OAF, follow steps one and two in “Checking the
Receiver’s OAF” on page 5-5.

2. Press Upload OAF at the bottom of the Receiver Options dialog
box (Figure 5-5 on page 5-5).

3. Navigate to the location of the new Option Authorization File,
select the appropriate file, and press Open (Figure 5-6).

& Open
C 30 ) [l « oAF » co001BQMRSWW v|¢,H Search OO
N NS
Organize New folder
BT Concept Document * Name . D)
Defect Data
[ C00LBQMRSWW.tpo
EPROM scripts
For Katrin
From Fraser
Integration documents - current versic =
Kits
OAF
| OOFSB2POGMS
| OM2VMESBVE
| Q001BQMRSWW
| O0LLZUN2QLE - i i
File name: [TENET ~| [options Files ("tpo) -

Figure 5-6. Load OAF

4. Sokkia SRU initially checks to see if the selected file is
compatible with the currently connected receiver. If a file not
intended for this receiver was selected, the Upload OAF dialog
box (Figure 5-7 on page 5-7) displays an error icon next to the
Receiver ID and disables the Upload the File to the Receiver
button.
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r .
= Upload OAF [E=SEE
VU IM5HAW 669-PP000 1\EQOVU IMSH4W. tpo @

-
&= Upload OAF (B | || Property Value -
[Flseriang - s59-PPOODL =
3\Projects\OAF\OAF \EP4YBKELEOO. tpo| [Elreceivern EcoVUMSHAW

Mode! 01-090101-30¢ GRX 1
Property value Echedcsum 537F E
EDealer Topcon Positioning Systems, Inc.
5EI’iE|NO 596-03519 Flemail DAbercrombie @topcon, com
ReceiverID EP4YBKBLGOD ESuhm\tT\mE 2010-01-15 00:08:06 L
Flmodel 01-080501-01GRS-1 | | [JCpher  Digest .
= amman: e RA-NGN1N1-77
Flchecksum  s50C < = b
EDeaIer Beijing Topcon B&T Co. - ‘
EEma" bmarsh@topcon. com [ Upload the File to the Receiver ]

[FlsubmitTime  2010-08-16 14:18:43
EOrdernumber 0030228701

[ rinker Ninact
< [ | +

Upload the File to the Receiver

Figure 5-7. Compatibility Check of OAF

Press Upload the File to the Receiver to start loading the file.

If an OAF file is uploaded to the receiver, SRU will display a
confirmation dialog box to reset the receiver and put new
authorization options into operation (Figure 5-8).

Press Yes on the confirmation dialog box (Figure 5-8).

= Upload OAF =8 X

Option Name Result H

TRU L

e 3
|0| The changes will take effect after reset. Reset the receiver?
L !

Upload the File to the Receiver ‘

Figure 5-8. Reset the Receiver Confirmation Dialog Box
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Loading New GNSS Firmware

Receiver board firmware is released as a compressed file that the user
can download and decompress. This file contains the following two
files:

* ramimage.ldr — the Receiver board RAM file
* main.ldp — the Receiver board Flash file
To upload firmware files to GRX1 receiver, do the following steps:

1. Connect your receiver and computer. Open SRU See
“Connecting the Receiver and a Computer” on page 2-3 for this
procedure.

2. Click on the Firmware Loader icon in the main window
(Figure 5-9).

On The Upload Firmware Loader dialog box (Figure 5-9) you
can upload firmware files to the connected receiver.

3. In the Device field, select Receiver/modem from the drop-down
list.

4. 1Inthe Capture Method field, select Soft Break (recommended)
from the drop-down list.

5. Browse for and select the receiver board’s RAM image file and
Main Flash file (Figure 5-9)

= e [E=SEE==C)
Device
Elm —’ ‘ ReceiverModem = |
Firmware —
Loader irmware
RAM Image (ld): C:yamimage.idr J
Firmware Loader Icon e |

Capture Method

[soft Break -

Start ’

Figure 5-9. Upload Firmware Loader Dialog Box

6. Press Start to upload the selected files (Figure 5-9).
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7. Press OK to complete uploading new firmware to the receiver
(Figure 5-10).

-
¥ Firmware Loader |£|E|iz_hj
Device
[Receiverjiodem -
Firmware
RAM Image (1d):  c:\amimage, S
€:yamimage. ldr - i
Main Flash (1dp): | Cymain.dp
Capture Method 0 The firmware has been successfully uploaded.
[softBreak =
Start |

Figure 5-10. Firmware — Successfully Loaded

Loading New Main Board Firmware

1. Perform factory reset on the receiver.
Remove storage card from the receiver.

3. Load the “acpu.sbc” file onto the storage card in a folder named
“Firmware”.

4. Insert the storage card back into receiver.
5. Power on the receiver.

6. Factory Reset the receiver.

than usual; the “|010” LED will be flashing, which

@ The receiver will power up 20-30 seconds slower
means that FW is upgrading.

7. Factory Reset the receiver once more to bring it back to its
factory settings.

8. Use SRU to ensure that the firmware has been upgraded (by
viewing the firmware version in the information screen).
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Clearing the NVRAM

The receiver’s Non-Volatile Random Access Memory (NVRAM)
holds data required for satellite tracking, such as ephemeris data and
receiver position. The NVRAM also keeps the current receiver’s
settings, such as active antenna input, elevation masks and recording
interval, and information about the receiver’s internal file system.

Even though clearing the NVRAM is not a common (nor normally a
recommended) operation, there are times when clearing the NVRAM
can eliminate communication or tracking problems. Clearing the
NVRAM in your receiver can be interpreted as a “soft boot” in your
computer.

After clearing the NVRAM, it takes around 15 minutes for the
receiver to collect new ephemerides and almanacs.

Clearing the NVRAM of your receiver will not delete any files
already recorded in your receiver’s memory. However, it will reset
your receiver to factory default values.

In addition, the NVRAM keeps information about the receiver file
system.

Using SRU to Clear the NVRAM

1. Connect your receiver and computer. Open the SRU. See
“Connecting the Receiver and a Computer” on page 2-3 for
details.

2. Click on the Tools icon in the main window.
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The Tools dialog box displays (Figure 5-11) that allows the user
to reset the receiver and to clear the NVRAM.

F |

(. 4 Tools SRRCE X
"f —
Tools Icon I
TRU =

I.-"'_"‘-.I After clearing NVRAM, the receiver will require some time to re-collect

L ¢ 4 data needed to track satellites, Continue?

Figure 5-11. Tools Dialog Box
3. Press Clear NVRAM on the Tools dialog box (Figure 5-11).
The SRU confirmation screen displays (Figure 5-11).

4. On the SRU confirmation screen, press Yes to continue
(Figure 5-11).
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Notes:
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Chapter 6

Troubleshooting

This chapter will help you diagnose and solve some common
problems you may encounter with your receiver.

_ﬂ'r Do not attempt to repair equipment yourself. Doing
N so will void your warranty and may damage the
[WARNING )
hardware.

Check This First!

Before contacting Sokkia support, check the following:

* Check all external receiver connections carefully to ensure
correct and secure connections. Double check for worn or
defective cables.

* Check all power sources for a drained battery or incorrectly
connected battery/cables.

* Check that the most current software is downloaded onto the
computer and that the most current firmware is loaded into the
receiver. Check out the Sokkia website for the latest updates.

Then, try the following:
* Restore default settings using SRU; click Tools » Factory Reset.
* Clear the NVRAM (see Figure 5-5 on page 5-5).

* Initialize the file system (File Explorer, then right click and select
Initialize File System). This will erase all files inside the SD/
SDHC card in receiver.

If the problem persists, see the following sections for other solutions.
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Troubleshooting Quick List

For receiver power issues:
If “The receiver does not power up,” see page 6-2.
For receiver issues:

If “The receiver does not lock on to satellites for a long period of
time,” see page 6-4.

If “The receiver tracks too few satellites,” see page 6-4.

If “The receiver cannot obtain Code Differential and/or RTK
solutions,” see page 6-5.

If “The receiver does not start logging data,” see page 6-7.
For Bluetooth connection issues:
If “SRU error message: Can’t find receiver,” see page 6-7.

If “SRU error message: Open COM# port failed: Access is
denied,” see page 6-9.

If “SRU error message: Open COM# port failed: Access is
denied,” see page 6-9.
If “No discovery of available devices,” see page 6-9.

If “Can see the icon for the receiver’s Bluetooth module on the
computer screen, but cannot connect to it,” see page 6-9.

For modem issues:
If “SRU cannot connect to the receiver,” see page 6-10.

| Clearing the NVRAM returns the receiver to Auto
% power mode (see “Clearing the NVRAM” on

page 5-10).

The receiver does not power up

> The attachable battery may be improperly attached.
* Check that the battery is correctly attached.

* Check that the battery contacts at the top of the attachable
battery are clean and dust free.

= The battery may be discharged.
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* Connect/attach a fully charged battery and retry. See
“Charging the Battery” on page 1-12.

* Charge the battery overnight. See “Charging the Battery” on
page 1-12.
= The cable may be disconnected or damaged if using an external
power source.
Check that the cable is securely connected and undamaged.

= The receiver may have a defective charger or defective battery.

After changing the battery or connecting an external power
source, if the receiver still does not power up, contact Sokkia
Customer Support for advice.

Receiver Problems

The following are some of the most commonly encountered receiver
problems.

The receiver cannot establish a connection to a computer or
external controller

Cable specific problems:

= The cable is not properly plugged in.
¢ Check that the cable connector is attached to the correct
receiver port.

* Unplug the cable, then securely and properly reconnect it to
the receiver.
* See “GRX1 Receiver” on page 1-8” and ‘“Radio (Modem)
RF Connector” on page A-15 for information on the
receiver’s connectors.
= The cable is damaged.

Use an undamaged cable. Contact your Dealer to replace the
cable.

Generic problems:
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= The receiver port used for connection is not in Command mode.

1. Connect your receiver and a computer using a free port
(see “Connecting the Receiver and a Computer” on
page 2-3) and start SRU.

Click Receiver Settings » Ports.

3. Change the Input for the port used for connection to
LGCmd77‘

The receiver does not lock on to satellites for a long period of
time

= The receiver stores an old almanac.

Update the almanac. See “Collecting Almanacs and
Ephemerides” on page 2-8 for details.

5 The corresponding receiver options may be disabled or expired
(L1/L2, GPS/GLONASS must be on to track satellites).

* See “Managing Receiver Options” on page 5-5 for details
on how to check current options.

* Order a new OAF with the desired options activated to
enable or extend validity of the corresponding receiver
options. Contact your dealer or visit the Sokkia website for
details

* Refer to the SRU Reference Manual for a detailed
description of options.

The receiver tracks too few satellites

= The survey is conducted near obstructions (tree canopy, tall
buildings, and so forth).

* Check that the Multipath Reduction boxes have been
enabled.

1. Connect your receiver and a computer and start
SRU. See “Connecting the Receiver and a
Computer” on page 2-3.

2. Click Receiver Settings » Tracking » Adv; then
enable Multipath Reduction settings.
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* Move to an area free of obstructions, if applicable.

The receiver cannot obtain Code Differential and/or RTK
solutions

= Incorrect Base coordinates entered.

Specify the correct coordinates for the Base station using
SRU or another suitable field data collection software.

= The receiver is not configured as a Base or Rover.
« If the receiver should function as a Base, ensure it has the
proper configuration. See Chapter 3 for details.

« If the receiver should function as a Rover, ensure it has the
proper configuration. See Chapter 3 for details.

= The corresponding receiver options may be disabled or expired.
* See “Managing Receiver Options” on page 5-5 for details
on how to check current options.

* Order a new OAF with the required options activated to
enable or extend validity of the corresponding receiver
options. Contact your dealer or visit the Sokkia website for
details

* Refer to the SRU Reference Manual for a detailed
description of options.

= There are not enough common satellites. In order to obtain a
fixed solution, the Base and Rover should track at least five
common satellites.

* Ensure that both the Rover and Base receivers use the
same, and updated, almanac. See “Collecting Almanacs
and Ephemerides” on page 2-8.

5 A discrepancy exists between the differential standards used at
the Base and Rover receivers.

Ensure the Base and Rover receivers use the same corrections
input/output format:

1. Connect your receiver and a computer and start SRU. See
“Connecting the Receiver and a Computer” on page 2-3.
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2. Click Configuration » Receiver, then the Ports tab. Use
the same input/output format for both receivers.

= The modem battery is low.

> The transmitting and/or receiving antenna may be improperly
connected.

* Check that the radio modem’s antenna is securely and
properly connected to the antenna connector.

* Check that the radio modem’s antenna is undamaged. If
damaged, contact your Sokkia dealer to replace the
antenna.

= The specified baud rate is incompatible with the baud rates the
modem supports.

The baud rate is the rate at which the receiver transmits

differential messages to the modem and vice versa.

* Change the baud rate to that which your modem supports.
Refer to the modem’s manual for information.

= The Base and Rover modems use different radio link
parameters.

Configure the Base and Rover radio modems according to the
procedures listed in the applicable section.

* For details on a UHF II radio modem, see “Topcon Digital
UHF II Modem” on page 3-4.

e For details on the Satel Radio, see “Satel Modem” on
page 3-10
= The distance between the Base and Rover is too far.
 Close the distance between the Base and the Rover.
» Use repeaters to increase radio coverage.
= There may be a source of radio interference that disrupts radio
communications.
* Change the RF channel (if possible).
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» Use a spectrum analyzer to detect the radio characteristics
of the interfering signal and change your system’s
configuration accordingly.

* Remove the source of jamming signal or relocate your
radio antennas (if possible).
The receiver does not start logging data
= The receiver has no SD/SDHC installed or the memory option
is disabled or expired.

* Check that the card is properly inserted. For details, see
“To install the SIM card” on page 1-22.

* Check that the memory option is enabled. For details, see
“Checking the Receiver’s OAF” on page 5-5.

= The receiver’s memory card has no free space.

* Download and/or delete data files to free up space for new
files (see “Downloading Files to a Computer” on page 5-1
and “Deleting Files From the Receiver Using SRU” on
page 5-3).

Connection Problems

The following are some of the most commonly encountered error
messages and other problems.

SRU error message: Can’'t find receiver

= The receiver is turned off.

Ensure the receiver has power and is turned on.

> If using a cable, the cable’s connectors are improperly attached.

¢ Check that the cable connector is attached to the correct
serial port.

* Unplug the cable, then securely and properly reconnect it to
the receiver.

> If using a cable, the cable is damaged.
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* Use an undamaged cable.
* Contact your Sokkia dealer to purchase a new cable.
= The COM port the receiver is attached to differs from the one
selected in SRU.

¢ Ensure that the RS232 serial cable is attached to the COM
port specified in the SRU communication port list.

» See “Establishing a Wireless Connection” on page 2-5 for
details.
= The receiver port used for connection is not in Command mode.

1. Connect your receiver and a computer using a free port
(see “Connecting the Receiver and a Computer” on
page 2-3) and start SRU.

Click Receiver Settings » Ports.

3. Change the Input for the serial port used for connection
to “Command”.

| This is the most common cause for this error
% message. Use SRU to double-check the settings for

the connection port.

= The settings for Port D may have been changed.

* The settings for Port D are: 115200 baud rate, 8 data bits, 1
stop bit, no parity, and no handshaking.

* Try enabling RTS/CTS handshaking for Port D. Do not
change other settings.

5 The corresponding receiver options may be disabled or expired
(serial port D must be enabled).
* See “Managing Receiver Options” on page 5-5 for details
on how to check current options.
* Order a new OAF with the required options activated to
enable or extend validity of the corresponding receiver

options. Contact your dealer or visit the Sokkia website for
details
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Connection Problems

* Refer to the SRU Reference Manual for a detailed
description of options.

SRU error message: Open COM# port failed: Access is denied

= Another application uses the computer port dedicated for
connection.

* Close the application, then re-connect.

* Connect the receiver via another, unused computer port.
No discovery of available devices

= The receiver is not receiving power.
* Check that the receiver is getting power and is turned on.

* Check that the power cable is attached to the port marked
‘GPWR,’.

* Unplug the cable, then securely and properly reconnect it to
the receiver.

* If the power cable is damaged, contact your Dealer to
purchase a new cable.
5> Slot 2(C) of the receiver is turned off.

1. Connect your receiver and a computer using an RS232
serial cable (see “Establishing an RS232 Serial Cable
Connection” on page 2-3).

. Click Receiver Settings » Bluetooth.

3. Inthe Turn on/off Slots area, enable the Slot 2(C) check

box.

Can see the icon for the receiver’s Bluetooth module on the
computer screen, but cannot connect to it

5 Device security settings probably differ.

* Make sure your Bluetooth enabled devices use the same
security settings.

* See “Establishing a Wireless Connection” on page 2-5.

= Bluetooth module settings may have changed.

P/N 7010-0965 6-9



Troubleshooting

1. If you changed settings for your Bluetooth module,
remove it from the list of discovered Bluetooth devices
using the Bluetooth manager program (supplied with the
device used to manage the receiver).

2. Repeat the search.

SRU Problems

The following is the most commonly encountered SRU problem.
SRU cannot connect to the receiver

= The receiver is turned off.

Ensure the receiver has power and is turned on.

> If using a cable, the cable’s connectors are improperly attached.

¢ Check that the cable connector is attached to the correct
serial port.

* Unplug the cable, then securely and properly reconnect it to
the receiver.
= If using a cable, the cable is damaged.
* Use an undamaged cable.
* Contact your Dealer to purchase a new cable.
= If using Bluetooth wireless technology, the incorrect port is

selected, or the receiver or computer does not support
Bluetooth.

* Use a computer or receiver that has Bluetooth wireless
technology enabled/installed.

* Check that the computer and receiver use the correct ports
for communication. For the GRX1 receiver, this is port A.

= The corresponding modem options may be disabled or expired.

* See “Managing Receiver Options” on page 5-5 for details
on how to check current options.
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Getting Technical Support

* Order a new OAF with the required options activated to
enable or extend validity of the corresponding receiver
options. Contact your dealer or visit the Sokkia website for
details

Getting Technical Support

If the troubleshooting hints and tips in this Operator’s Manual fail to
remedy the problem, contact Sokkia Customer Support.

Website

The Sokkia website provides current information about Sokkia’s line
of products. The support site provides access to Sokkia field and
office software, manuals, frequently asked questions, and so forth.

To access the Sokkia website, visit www.sokkia.com.

To access the Sokkia support site, visit www.sokkiasupport.com.

Phone

To contact Sokkia Customer Support by phone, call:
¢ 1-800-4-Sokkia or 1-800-476-5542
* 1-866-4-Topcon or 1-866-486-7266
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Troubleshooting

Notes:
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Appendix A

Specifications

This Sokkia product is a 72-channel GNSS receiver with an internal
radio modem, a Bluetooth wireless technology module, an optional
GSM, HSPA, or CDMA modules, an optional, removable SD/SDHC
memory card, and a rugged magnesium housing complete with an
LED Display Panel and cable connectors.

Receiver Specifications

The following sections provide specifications for the receiver and its
internal components.

General Details
Table A-1 lists the receiver’s general specifications.

Table A-1. Receiver General Specifications

Physical

Enclosure Magnesium alloy housing

Color Sokkia Blue and Sokkia Gray
Dimensions 184 x H 95mm (7.24 x H 3.74 in)
Weight:

o GRXI receiver 1.1kg (2.43 1b.)

« BDC58 battery | 199869 0z.) _
115 to 230g (4.1 to 8.2 o0z.), depending on modem
* Internal modems

specifications
Antenna Internal
Battery Built-in, detachable/replaceable
Controller External
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Specifications

Table A-1. Receiver General Specifications (Continued)

Mounting 5/8-11, quick release
Seals Silicon
Keys One key:
Power (On/Off)
Status LEDs 22 Status LEDs:
Indicators * Receiver Health Status

¢ Scheduler Status

¢ Available Power Bar
¢ Battery Status

» Satellite Tracking Bar
¢ Position Status

¢ Memory Capacity Bar
» File Status

* Wireless Status

* Radio Status

¢ Serial Port Status

Voice navigation

Multi-lingual voice messages for receiver status

Environment

Operating
temperature

¢ GRXI1 receiver — -40 to +65°C (-40 to +149°F)
¢ BDCS58 battery — -20 to +65°C (-4 to +149°F)
¢ UHF/GSM modems — -20 to +55°C (-4 to +131°F)

Storage temperature

-45°C to +70°C (-49 to +158°F)

Humidity 100% condensation

Dust/Water P67 (IEC 60529:2001) with all connector caps closed.

Protection Protected against temporary immersion up to 1m (3.3ft)
depth.

Shock 2m (6.56ft) pole drop

Power

Built in battery,
Rechargeable

BDC58 Li-ion 4,300mAh (Typical) / 7.2V DC

A-2
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Receiver Specifications

Table A-1. Receiver General Specifications (Continued)
Battery weight 195¢g
Battery charging 4 hours at 25°C (77°F)
time

Operating time

Over 7.5 hours (20°C /68°F) / Only static tracking / with
Bluetooth connection)

External power

1 port

Charger CDC68:

¢ Recharging time
¢ Input voltage
External Power:

Approx. 4 hours at 25°C (77°F)
100 to 240V AC (50/60Hz)?

« Input voltage 6.7 to 18V DC

Consumption 4W (w/o UHF modem)

Battery charge Uses CDC68

On-board Backup battery for NVRAM and RTC storage;

Operation for approximately 100 days.

Data Management

Memory

SD/SDHC card (FAT16/32 formats)

Data format

RTCM SC104 2.1/2.2/2.3/3.0/3.1, CMR, CMR+, NMEA,
TPS

Update/output rate® | 1Hz, 5Hz, 10Hzm 20Hz
Communication RS-232C (4,800 to 115,200bps)
Port

Port specifications

COMI: 4,800 to 115,200 bps (RS Level)
115,200bps (default)
Bluetooth: 115,200bps (SPP / Single Channel mode)

LED Display Panel

Modem Antenna (BNC or reverse polarity TNC
depending on modem type), PWR, RS232C Serial cable
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Specifications

Table A-1. Receiver General Specifications (Continued)

Wireless communication

Bluetooth modem V1.1.1, Class 1, 115,200bps

Digital UHF II Internal, receiver (RX) and transmitter (TX)

modem® 410 to 470MHz

GSM / HSPA / Internal

CDMA modem¢

NMEA

NMEA version Ver. 2.1,2.2,2.3,3.0

Messages GGA, GLL, GNS, GRS, GSA, GST, GSV, HDT, RMC,
VTG, ZDA, ROT, GMP

Output interval 10Hz, 20Hz, 50Hz, and 100Hz

DGPS

Correction format RTCM SC104 Ver 2.1,2.2,2.3, 3.0, 3.1

RTCM message 1,3,9, 31, 32, 34; user selectable
type
Process interval 10Hz standard; 20Hz, 50Hz, and 100Hz optional

Output interval for 10Hz standard; 20Hz, S0Hz, and 100Hz optional
RTCM correction
data

Elevation mask 0 to 90° (independent of data logging)

RTK

Correction format CMR2/CMR+, RTCM SC104 Ver 2.2,2.3,3.00r 3.1

RTCM message 3,18, 19, 20, 21, 22; user selectable
type

Ambiguity initialize | OTF (L1, L1/L2)

Baseline Length Up to 50km in the morning and evening
Up to 32km at noon
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Table A-1.

Receiver Specifications

Receiver General Specifications (Continued)

Initialize time

5 seconds to 10 minutes depending on the base line length
and multipath conditions

Output interval for
CMR/RTCM

10Hz standard; 20Hz, 50Hz, and 100Hz optional

Elevation

0 to 90 degrees (independent of data logging)

Solution mode

Delay (synchronization)
Extrapolation (not synchronized)

Process interval

10Hz standard; 20Hz, 50Hz, and 100Hz optional

Positioning Accuracy®

Static

L1 only:
H: 3mm + 0.8ppm (x baseline length)
V:4mm + 1.0ppm (x baseline length)
L1+L2:
H: 3mm + 0.5ppm (x baseline length)
V:5mm + 0.5ppm (x baseline length)

Fast Static

L1+L2:
H: 3mm + 0.5ppm x D
V:5mm + 0.5mm x D

Kinematic L1+L2:
H: 10mm +1ppm x D
V:15mm +1mm x D
RTK L1/L1 4+L2:
H: 10mm + 1.0ppm (x baseline length);
V: 15mm + 1.0ppm (x baseline length)
DGPS Post processing/RTCM:
Typically less than 0.5m (RMS)
Cold start < 40sec
Warm start < 20sec (typical)
Reacquisition < lIsec
a. Use with an appropriate AC power cable.
b. 1Hz standard. Higher rates available as option.
c. Internal “UHF modem” available as factory option.
d. Internal “UHF+GSM/HSPA/CDMA modem” available as factory
option.
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Specifications

e. Accuracy depends on the number of satellites used, obstructions,
satellite geometry (DOP), occupation time, multipath effects,
atmospheric conditions, baseline length, survey procedures and data
quality.

GPS satellites above 15 degrees in elevation and
following the procedures recommended in this
manual.

@ Performance specifications assume a minimum of 6

In areas of high multipath, during periods of large
PDOP, and during periods of increased ionospheric
activity, performance may degrade.

Use robust checking procedures in areas of extreme
multipath or under dense foliage.

ST
&>

GPS Board Details
Table A-2 lists general specifications for the GPS board.

Table A-2. GPS Board Specifications

Receiver Type (set by activating the proper OAF)

Internal board: G: GPS L1

GRX1 GD: GPS L1/1.2
GG:GPS/GLONASS L1
GGD: GPS/GLONASS L1/L.2

Hardware type: with Digital UHF II
country/region/ with Digital UHF II + GSM
purpose dependent with Digital UHF II + HSPA
with Digital UHF II + CDMA
with SATEL + GSM

Tracking Specifications
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Receiver Specifications

Table A-2. GPS Board Specifications (Continued)

Standard Channels

72 universal channels L1 CA, L1 P-code, L2C GPS and
GLONASS, WAAS/EGNOS, PCode and Carrier

Tracked Signals?

GPS: L1 CA, L1/L2 P-code, L2C
GLONASS: L1/L2 CA, L1/L2 P-code
SBAS: WAAS, EGNOS, MSAS

Tracking Functions

Multi-path Code and Carrier
reduction
PLL/DLL setting Bandwidth, order, adjustable

Co-op tracking loop
setting

On/Off, Static Mode,
Bandwidth of individual PLL
Bandwidth of common PLL

Smoothing interval

Code and Carrier

WAAS/EGNOS/
MSAS

Optional

Data Features

Formats

TPS, NMEA, RTCM, CMR

Features

Up to 100 Hz update rate for real time position and raw
data (code and carrier)

10cm code phase and 0.1mm carrier phase precision
RTCM SC104 version 2.1, 2.2, 2.3, 3.0, and 3.1 I/O
Multiple Base RTCM

Geoid and Magnetic Variation models RAIM

Different DATUMs support

Output of grid coordinates

CMR and CMR+ support

Memory

Internal Memory

SD/SDHC card, removable

Capacity Dependent upon the capacity of the installed SD/SDHC
card
Logging Interval 0.05 to 86,400 seconds, depending on purchased options
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Specifications

a. Number of channels and tracked signals vary according to receiver
configurations.

Cinderella days is an option that turns a single

@ frequency GPS receiver into a dual-frequency
GNSS receiver for 24 hours every other Tuesday at
GPS midnight.

Refer to Sokkia’s website for more information and specific
Cinderella day events.

Internal UHF Satel Modem Details

Table A-3 lists general specifications for the internal UHF Satel
modem.

Table A-3. Internal UHF Satel Modem Specifications

General

Frequency Range 380—470; according to country
TX: specific 2MHz frequency range allocated
according to country
RX: 3 frequency ranges from 410-430MHz,
430-450MHz, or 450-470MHz

Channel spacing 25 kHz (for Germany, 12.5 kHz)

Number of channels Four to Six

Frequency stability <*1.5kHz

Type of emission F1D

Communication mode Half-duplex

Data speed of serial interface 300-38400 bps

Data speed of radio interface 19200 bps (25kHz channel)
9600 bps (12.5kHz channel)

Data format Asynchronous
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Receiver Specifications

Table A-3. Internal UHF Satel Modem Specifications (Continued)

Transmitter (TX)

Carrier power 10mW-1W/50 ohms

Carrier power stability +2dB /-3 dB

Adjacent channel power according to EN 300 220-1/ETS 300 113
Spurious radiations according to EN 300 220-1/ETS 300 113

Receiver (RX)

Sensitivity -116...-110 dBm (BER<10 E-3)

Common channel rejection > 12dB

Adjacent channel selectivity >60dB @ 12.5 kHz
>70dB @ 25 kHz

Intermodulation attenuation >65dB

Spurious radiation < 2nW
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Specifications

Internal Topcon Digital UHF 1l Modem
General Specification Details?

Table A-4. Topcon Digital UHF Il Specifications

General

Operating frequency ramgeb

UHF 400 - 470 MHz

Modulation techniques

GMSK and 4-Level FSK (4FSK)

Protocols®d

Satel 4FSK

PDL GMSK
PDL 4FSK
TrimTalk GMSK

Occupied bandwidth® (channel spacing)

25 kHz, 20 kHz or 12.5 kHz

Data transmission rate at 25 kHz 9600 bps GMSK
Channel Spacing 19200 bps  4FSKY
Data transmission rate at 20 kHz 4800bps  GMSK
Channel Spacing 9600 bps  4FSK
Data transmission rate at 12.5 kHz 4800 bps  GMSKY
Channel Spacing 9600 bps ~ 4FSKY

Data speed of serial (RS-232) interface

Max 115200 bps

Forward Error Correction (FEC) Yes
Scrambling Yes
Communication mode Half-duplex
Operation modes Transmitter
Receiver
Repeater

a For complete detail on Topcon Digital UHF II modem, refer to 7Topcon
Radio Guide Reference Manual (PN: 1001598-01).

b Dependent on country and region, and mode (base/rover) of operation.
Contact your Dealer, or local government radio authority to understand
licensed radio frequency requirements in your area.
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Receiver Specifications

¢ Use of PDL and Satel 4FSK protocols is recommended in applications
where possible. Note that a minimum baud rate of 9600 bps is
recommended for all RTK operations. Compatibility with TrimTalk is
subject to some restrictions.

4 The data transmission configurations indicated (protocol and channel
spacing) are the only protocols that provide compliance with UHF
Narrowbanding restrictions that are effective as of January 1, 2013 in
the US and Canada. For more information, please see http://
transition.fcc.gov/pshs/public-safety-spectrum/narrowbanding-fag.html
Jor details. Similar restrictions are also in place in other global
markets. Please contact your Dealer or local government radio
authority to ensure you understand local compliance obligations.

Bluetooth Module Details

Table A-5 lists the Bluetooth wireless technology module’s general
specifications.

Table A-5. Bluetooth Module Specifications

Range Up to 10 m (indoor), up to 50m (outdoor)
Type Class 1
Service classes Miscellaneous

Supported profiles SPp

Frequency Country | North America and Europe
Code

Optional Cell Module Details
Table A-6 lists cellular specifications.

Table A-6. Cellular Specifications

Quad Band GSM/GPRS/EDGE Module

Supported Bands GSM 850/900/1800/1900 MHz
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Specifications

Table A-6. Cellular Specifications (Continued)

TX Power 850/900 MHz — Class 4 (2 Watt)
1800/1900 MHz — Class 1 (1 Watt)

Data Features GPRS, Multi-slot Class 10, Max downlink
85.6 kbps, max uplink 42.8 Kbps

EDGE, Multi-slot Class 10, Max BR
downlink 236.5 Kbps

CSD, Max BR 14.4 Kbps

AT Command Set GSM 07.05, 07.07 and 07.10

Regulatory and Approvals FCC, IC

ANATEL (Brazil)
COFETEL (Mexico)
CMII (China)

PTCRB

R&TTE/CE

GCF

QS9000 manufacturing
RoHS/WEEE/CCC

Dual Band CDMA 1xRTT Module

Supported Bands' CDMA 800/1900 MHz
TX Power 800 MHz — Class 3 (24 dBm)
1900 MHz — Class 2 (24 dBm)
Data 1x/QNC/HSPD
CSD, Max BR 14.4 Kbps
AT Command Set N/A
Regulatory and Approvals CDGl1, CDG2
FCC, IC, cCC
EMC
QS9000 manufacturing
RoHS/WEEE

'Topcon GNSS receivers equipped with integrated C24 wireless modules

are authorized to operate in the US only on the Verizon™ wireless
network.
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Receiver Specifications

Table A-6. Cellular Specifications (Continued)

3.5G Wireless Module (Quad-band GSM and UMTS/HSPA)

Supported Bands GSM 850/900/1800/1900 MHz
UMTS/HSPA 850/1900/2100 MHz
TX Power UMTS/HSPA - Class 3 (0.25 Watt)

GSM 850/900 MHz — Class 4 (2 Watt)

GSM 1800/1900 MHz — Class 1 (1 Watt)
EDGE 850/900 MHz — Class E2 (0.5 Watt)
EDGE 1800/1900 MHz — Class E2 (0.4 Watt)

Data Features

UMTS/HSDPA/HSUPA 3GPP, Release 6
GSM/GPRS 3GPP, Release 9

Max uplink 5.76 Mbps, max downlink 7.2
Mbps

EDGE, Multi-Slot class 12

CSD, Max BR 14.4 Kbps GSM, Max BR 14.4
Kbps UMTS

AT Command Set

GSM 07.05, 07.07

Regulatory and Approvals

FCC, IC
ANATEL (Brazil)
PTCRB
R&TTE/CE

GCF
RoHS/WEEE
ACMA

BABT
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Specifications

Battery (BDC58) Specifications
Table A-7 lists the BDC58 battery specifications.

Table A-7. Battery Specifications

General

Nominal voltage 7.2V

Capacity 4.3Ah

Dimensions 38 (W) x 70 (D) x 40 (H) mm
Weight about about 195g

Charger (CDC68) Specifications
Table A-8 lists specifications for the CDC68 charger.

Table A-8. Charger Specifications

General
Input voltage: AC100 to 240V
Charging time per about 4 hours

battery (at 25°C)
(Charging can take longer than the times stated above
when temperatures are either especially high or low.)

Charging 0 to 40°C
temperature range

Storage temperature | -20 to 65°C

range
Size: 94 (W) X 102 (D) X 36 (H) mm
Weight: about 170g
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Connector Specifications

Connector Specifications

The GRX1 has 3 external connectors; one UHF radio modem
connector, one power connector, and one serial port connector.

Table A-9, Table A-11 on page A-16, and Table A-12 on page A-17
list the specifications for the external connectors.

Table A-9. UHG Modem Connector Specifications

Modem Type Signal Type Dir Details

UHF BNC Modem I/0 /0 RF/GSM output from
modem antenna

Radio (Modem) RF Connector

The modem connector (Table A-10) is a reverse polarity TNC
connector for spread spectrum and a BNC connector for Digital and
Satel modem.

Table A-10. Modem Connector Specifications

Modem Type Signal Type Dir Details
Spread Reverse Modem 1/0 1’0 RF/GSM input/
Spectrum polarity TNC output to/from

modem antenna

Digital/ BNC Modem 1/0 /0 RF/GSM input/
Satel output to/from
modem antenna
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Specifications

Power Connector

Rimmed in red, the power connector (Figure A-1) is a sealed
receptacle, 5 pin, ODU part number G8OF1C-T05QF00-0000.

P —

Figure A-1. Power Connector

Table A-11 describes power connector specifications.

Table A-11. Power Connector Specifications

Number Signal Name Dir Details
1 Power_INP P 9 to 21 volts DC input
2 Power_INP P 9 to 21 volts DC input
3 Power_GND P Ground, power return
4 Power_GND P Ground, power return
5 Aux_Power P 9 to 21 volts DC input
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C-RS232 Serial Cable Connector

Power Connector

Rimmed in black, the RS232 serial cable connector (Figure A-2) is an
8 pin sealed receptacle.

®

e
9 ® @
D 6

Figure A-2. RS232 Serial Connector

Table A-12 gives the RS232 serial cable connector specifications.

Table A-12. RS232 Serial Connector Specifications

Number Signal Name Dir Details
1 Not used
2 RXD Input Receive data
3 TXD Output | Transmit data
4 GND 1’0 Signal ground
5 GND 1’0 Signal ground
6 Not used
7 RTS Output | Request to send
8 CTS Input Clear to send
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Specifications

USB Connector

Rimmed in yellow, the USB connector is a sealed receptacle, 4 pin
TPS cable connector (Figure A-3).

Figure A-3. USB Connector for GGD Options

Table A-13 gives the USB connector specifications.

Table A-13. USB Specifications

Number Signal Name Dir Details
1 USB_PWR P Bus power input
2 USB D- 1/0 Data minus
3 USB D+ 1/0 Data plus
4 GND - Ground
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Appendix B

Safety Warnings

General Warnings

ST

To comply with RF exposure requirements,
maintain at least 25cm between the user and the
radio modem.

Ml

[WARNI

NG )

Sokkia receivers are designed for survey and survey
related uses (that is, surveying coordinates,
distances, angles and depths, and recording such
measurements). This product should never be used:

* Without the user thoroughly understanding this
manual.

* After disabling safety systems or altering the
product.

* With unauthorized accessories.
» Without proper safeguards at the survey site.

* Contrary to applicable laws, rules, and
regulations.

S

Sokkia receivers should never be used in dangerous
environments. Use in rain or snow for a limited
period is permitted.
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Safety Warnings

Battery Pack Warnings

Never attempt to open the casing of the detachable
battery! Lithium-Ion batteries can be dangerous if
mishandled!

Do not incinerate or heat battery pack above 212
degrees fahrenheit (100 degrees celsius). Excessive
heat can cause serious damage and possible
explosion.

(W

ARNI

Tampering with the battery by end users or non-
factory authorized technicians will void the
battery’s warranty.

Do not attempt to open the battery pack or
replace it.

Do not disassemble the battery pack.

Do not charge in conditions different than
specified.

Do not use other than the specified battery
charger.

Do not short circuit.

Do not crush or modify.
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Usage Warnings

Usage Warnings

e

If this product has been dropped, altered,
transported or shipped without proper packaging, or
otherwise treated without care, erroneous
measurements may occur.

The owner should periodically test this product to
ensure it provides accurate measurements.

Inform Sokkia immediately if this product does not
function properly.

Only allow authorized Sokkia warranty service
centers to service or repair this product.
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Safety Warnings

Notes:
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Appendix C

Regulatory Information

The following sections provide information on this product’s
compliance with government regulations for use.

UHF Radio Usage

@ Using a UHF radio requires a license. Operating a

UHF radio without a license may result in fines or
other penalties. Be sure you comply with all local
laws before operating a UHF radio. Contact your
local authorities (such as, the FCC in the United
States) for details.

Surveying in RTK mode has made UHF the most popular choice for
communications between Base and Rover receivers. Know the
strengths and weaknesses of this technology to get the best use out of
your receiver. The quality and strength of the UHF signals translates
into range for UHF communications.

1. The system’s range will greatly depend on the local conditions.
Topography, local communications and even meteorological
conditions play a major role in the possible range of RTK
communications. If needed, use a scanner to find clear channels.

2. The system’s range will increase by adjusting the Base station’s
antenna using the following methods.
* Ensure the Base radio has a fully charged battery.

» Use directional antennas and/or repeaters to increase your
system’s range. Directional antennas concentrate the signal
power within a more narrow direction, significantly
increasing the range of your system.
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Regulatory Information

* Check the Sokkia accessory line for items to raise the Base
radio.

FCC Compliance

This equipment complies with FCC radiation exposure limits
set forth for uncontrolled equipment and meets the FCC radio
frequency (RF) Exposure Guidelines in Supplement C to
OET®65. This equipment has very low levels of RF energy that it
deemed to comply without maximum permissive exposure
evaluation (MPE). But it is desirable that it should be installed
and operated with at least 30cm and more between the radiator
and person’s body (excluding extremities: hands, wrists, feet
and ankles). This device complies with Part 15 of the FCC
rules. Operation is subject to the following two conditions:

1. This device may not cause harmful interference.

2. This device must accept any interference received, including
interference that may cause undesired operation.

This equipment has been tested and found to comply with the
limits for a digital device, pursuant to Part 15 of the FCC rules.
These limits are designed to provide reasonable protection
against harmful interference in residential installations. This
equipment generates, uses, and can radiate radio frequency
energy, and if not installed and used in accordance with the
instructions, may cause harmful interference to radio
communications. However, there is no guarantee that
interference will not occur in a particular installation. If this
equipment does cause interference to radio or television
equipment reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct
the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

» Move the equipment away from the receiver.
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Canadian Emission Labeling Requirements

* Plug the equipment into an outlet on a circuit different from
that to which the receiver is powered.

* Consult the dealer or an experienced radio/television
technician for additional suggestions.

Any changes or modifications to the equipment not expressly
@ approved by the party responsible for compliance could void

your authority to operate such equipment.

Canadian Emission Labeling
Requirements

This equipment complies with IC radiation exposure limits set forth
for uncontrolled equipment and meets RSS-102 of the IC radio
frequency (RF) Exposure rules. This equipment has very low levels
of RF energy that it deemed to comply without maximum permissive
exposure evaluation (MPE). But it is desirable that it should be
installed and operated with at least 30cm and more between the
radiator and person’s body (excluding extremities: hands, wrists, feet
and ankles).

1. Operation is subject to the following two conditions: (1) this
device may not cause interference, and (2) this device must
accept any interference, including interference that may cause
undesired operation of the device.

2. To reduce potential radio interference to other users, the antenna
type and its gain should be so chosen that the equivalent
isotropically radiated power (e.i.r.p.) is not more than that
permitted for successful communication.

3. This Class B digital apparatus meets all requirements of the
Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte conform a la norme
NMB-003 du Canada.
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Regulatory Information

IC RF Radiation Exposure Statement

The installer of this device must ensure that the antenna is located or
pointed such that it dose not emit RF field in excess of Health Canada
limits for the general population; consult Safety Code 6, obtainable
from Health Canada’s website at www.hc-sc.gc.ca/rpb.

IC Additional statement with Detachable Antennas
This device has been designed to operate with the antennas listed
below, with a maximum gain of 2.4dB. Antennas not included in the
list below or those having a gain greater than 2.4 dB are strictly
prohibited for use with this device. The required antenna impedance
is 50 ohms.

* GRX1/U 2.4dBi whip antenna Manufacture/Type

410-440MHz  ANTENEX/G420BN

440-470MHz CENTURION/EVR450

Community of Europe
Compliance

The product described in this manual is in compliance with the
R&TTE and EMC directives from the European Community.

European Community Declaration of
Conformity with R&TTE Directive 1999/5/EC

The following standards were applied:

¢ (R&T*TE Directive 1999/5/EEC)
ETSI EN 300 113-1 v1.7.1(2011-11)
ETSI EN 300 113-2 v1.5.1(2011-11)
ETSI EN 301 489-1 v1.9.2(2011-09)
ETSI EN 301 489-7 v1.3.1(2005-11)
ETSI EN 301 908-1 v5.2.1(2011-05)
ETSI EN 301 908-2 v5.2.1(2011-07)
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Community of Europe Compliance

ETSIEN 300328  v1.7.1 (2006-10)
ETSI EN 301 489-3 v1.4.1(2002-08)
ETSI EN 301 489-24 v1.4.1(2009-05)
ETSI EN 301 489-5 v1.3.1 (2002-08)
ETSI EN 301 489-17 v2.1.1 (2009-05)
ETSI EN 301 511 v9.0.2 (2003-03)
EN 62311:2008

EN 60950-1:2006/A1:2010

The following CE mark is affixed to the device.

430,

Equipment that is labeled with a C€® marking
informs users that the DIG UHF frequency range

410-470 Mhz is not harmonized throughout Europe
and that the specific country spectrum authority
should be notified before a radio modem is used.

This equipment is intended to be marketed in these countries.
List of National Codes

AT DE MT GB
BE GR NL IS
CY HU PL LI
CZIE PT NO
DK IT SK CH
EE LV SI BG
FILT ES RO

FR LU SE TR
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Regulatory Information

Declaration of Conformity with
Regard to the R&TTE Directive

1999/5/EC

esky (Sokkia) timto prohlasuje, ze tento (GRX1) je ve

[Czech] shod se zakladnimi pozadavky a dalSimi pislusSnymi
ustanovenimi smrnice 1999/5/ES.

Dansk Undertegnede (Sokkia) erkleerer herved, at

[Danish] folgende udstyr (GRX1) overholder de vaesentlige
krav og gvrige relevante krav i direktiv 1999/5/EF.

[eclbeutsch || Hiermit erklart (Sokkia) dass sich das Gerat (GRX1)

[German] in Ubereinstimmung mit den grundlegenden
Anforderungen und den Ubrigen einschlagigen
Bestimmungen der Richtlinie 1999/5/EG befindet.

Cetleesti Kaesolevaga kinnitab (Sokkia) seadme (GRX1)

[Estonian] vastavust direktiivi 1999/5/EU p&hinduetele ja
nimetatud direktiivist tulenevatele teistele
asjakohastele satetele.

English Hereby, (Sokkia) declares that this (GRX1) is in
compliance with the essential requirements and
other relevant provisions of Directive 1999/5/EC.

LesJespariol Por medio de la presente (Sokkia) declara que el

[Spanish] (GRX1) cumple con los requisitos esenciales y
cualesquiera otras disposiciones aplicables o
exigibles de la Directiva 1999/5/CE.

[Greek] ME THN NAPOYZA (Topcon Positioning Systems,
Inc.) AHAQNEI OTI (GRX1) ZYMMOPOONETAI
MPOZ TIZ OYZINAEIZ AMAITHZEIZ KAI TIZ AOINE:
ZXETIKEZ ATATAZEIZ THZ OAHINAZ 1999/5/EK.

[ Jrrancais | Par la présente (Sokkia) déclare que I'appareil

[French] (GRX1) est conforme aux exigences essentielles et

aux autres dispositions pertinentes de la directive
1999/5/CE.
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Italiano
[Italian]

Latviski

[Latvian]

ELietuvi

[Lithuanian]

ENederlan
ds [Dutch]

[mdmalti
[Maltese]

Magyar

[Hungarian]

Lt polski
[Polish]

Portugué

s
[Portugues]

Slovensk

o
[Slovenian]

[eals ovensy
[Slovak]

P/N 7010-0965

Declaration of Conformity with Regard to the R&TTE

Con la presente (Sokkia) dichiara che questo
(GRX1) e conforme ai requisiti essenziali ed alle
altre disposizioni pertinenti stabilite dalla direttiva
1999/5/CE.

Ar 30 (Sokkia) deklar, ka (GRX1) atbilst Direktvas
1999/5/EK btiskajm prasbm un citiem ar to
saisttajiem noteikumiem.

Siuo (Sokkia) deklaruoja, kad $is (GRX1) atitinka
esminius reikalavimus ir kitas 1999/5/EB Direktyvos
nuostatas.

Hierbij verklaart (Sokkia) dat het toestel (GRX1) in
overeenstemming is met de essentiéle eisen en de
andere relevante bepalingen van richtlijn 1999/5/
EG.

Hawnhekk, (Sokkia), jiddikjara li dan (GRX1)
jikkonforma mal-tiijiet essenzjali u ma
provvedimenti orajn relevanti li hemm fid-Dirrettiva
1999/5/EC.

Alulirott, (Sokkia) nyilatkozom, hogy a (GRX1)
megfelel a vonatkoz6 alapvetd kévetelményeknek
és az 1999/5/EC iranyelv egyéb elbirasainak.

Niniejszym, (Sokkia), deklaruj, e (GRX1) spenia
wymagania zasadnicze oraz stosowne
postanowienia zawarte Dyrektywie 1999/5/EC.

(Sokkia) declara que este (GRX1) esta conforme
com Os requisitos essenciais e outras disposigdes da
Directiva 1999/5/CE.

(Sokkia) izjavlja, da je ta (GRX1) v skladu z
bistvenimi zahtevami in ostalimi relevantnimi doloili
direktive 1999/5/ES.

(Sokkia) tymto vyhlasuje, Ze (GRX1) spa zakladné
poziadavky a vSetky prislusné ustanovenia
Smernice 1999/5/ES.
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[idsuomi (Sokkia) vakuuttaa taten ettd (GRX1) tyyppinen

[Finnish] laite on direktiivin 1999/5/EY oleellisten
vaatimusten ja sité koskevien direktiivin muiden
ehtojen mukainen.

Svenska Harmed intygar (Sokkia) att denna (GRX1) star |

[Swedish] Overensstammelse med de vasentliga
egenskapskrav och dvriga relevanta bestammelser
som framgar av direktiv 1999/5/EG.

WEEE Directive

The following information is for EU-member states only:

Use of the symbol below indicates that this product may not be
treated as household waste. By ensuring this product is disposed of
correctly, you will help prevent potential negative consequences for
the environment and human health, which could otherwise be caused
by inappropriate waste handling of this product. For more detailed
information about the take-back and recycling of this product, please
contact your supplier where you purchased the product or consult.



Appendix D

Warranty Terms

Sokkia laser and electronic positioning equipment are guaranteed
against defective material and workmanship under normal use and
application consistent with this Manual. The equipment is guaranteed
for the period indicated, on the warranty card accompanying the
product, starting from the date that the product is sold to the original

purchaser by Sokkia’s Authorized Dealers.!

During the warranty period, Sokkia will, at its option, repair or
replace this product at no additional charge. Repair parts and
replacement products will be furnished on an exchange basis and will
be either reconditioned or new. This limited warranty does not
include service to repair damage to the product resulting from an
accident, disaster, misuses, abuse or modification of the product.

Warranty service may be obtained from an authorized Sokkia
warranty service dealer. If this product is delivered by mail, purchaser
agrees to insure the product or assume the risk of loss or damage in
transit, to prepay shipping charges to the warranty service location,
and to use the original shipping container or equivalent. A letter
should accompany the package furnishing a description of the
problem and/or defect.

The purchaser’s sole remedy shall be replacement as provided above.
In no event shall Sokkia be liable for any damages or other claims
including any claim for lost profits, lost savings, or other incidental or
consequential damages arising out of the use of, or inability to use,
the product.

1. The warranty against defects in a Sokkia battery, charger, or cable is 90
days.

P/N 7010-0965 D-1



Warranty Terms

Notes:
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